
Micro Focus Enterprise Developer 2.2
Update 2 for Visual Studio

Release Notes



Micro Focus
The Lawn
22-30 Old Bath Road
Newbury, Berkshire RG14 1QN
UK
http://www.microfocus.com
  

Copyright © Micro Focus 2012-2014. All rights reserved.

MICRO FOCUS, the Micro Focus logo and Enterprise Developer are trademarks or registered
trademarks of Micro Focus IP Development Limited or its subsidiaries or affiliated
companies in the United States, United Kingdom and other countries.

All other marks are the property of their respective owners.

2014-12-12

ii



Contents

Micro Focus Enterprise Developer 2.2 Update 2 for Visual Studio Release Notes
............................................................................................................................. 4

Installation .......................................................................................................... 6
System Requirements .........................................................................................................6

Hardware Requirements .......................................................................................... 6
Operating Systems Supported ................................................................................. 7
Software Requirements ............................................................................................7
Additional Software Requirements on Windows .......................................................9
Additional Software Requirements for Micro Focus Enterprise Developer Unix Components

............................................................................................................................... 15
Installing Enterprise Developer for Visual Studio .............................................................. 20

Downloading the Product ....................................................................................... 20
Product Co-Existence .............................................................................................20
Installation restrictions and requirements ...............................................................21
Installing and Licensing Micro Focus Rumba .........................................................21
Installing as an Upgrade .........................................................................................22
Installing ................................................................................................................. 22
Enterprise Developer Installation Options .............................................................. 23
Microsoft Terminal Server ......................................................................................24
Installing from a Server .......................................................................................... 24
Windows Compatibility Mode ................................................................................. 25
After Installing .........................................................................................................25
Repairing ................................................................................................................27
Installing Micro Focus Enterprise Developer Unix Components ............................ 27
Installing Mainframe Access Server ....................................................................... 31
Uninstalling .............................................................................................................34

Licensing Information ......................................................................................36
To buy and activate a full unlimited license ....................................................................... 36
To start Micro Focus License Administration ....................................................................36
Installing licenses .............................................................................................................. 36

If you have a license file ......................................................................................... 36
If you have an authorization code ...........................................................................37

To obtain more licenses .................................................................................................... 38
New Features in Enterprise Developer 2.2 Update 2 .....................................39
Known Issues ................................................................................................... 44
Significant Changes in Behavior or Usage ....................................................47
Resolved Issues ............................................................................................... 52
Updates and SupportLine ................................................................................76

Further Information and Product Support ......................................................................... 76
Information We Need ........................................................................................................ 76
Creating Debug Files ........................................................................................................ 77

Disclaimer ......................................................................................................... 78

Contents | 3



Micro Focus Enterprise Developer 2.2
Update 2 for Visual Studio Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Enterprise Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM
DB2, IBM z/OS file formats and common batch utilities, including SORT. This means that you can develop
and maintain the core mainframe online and batch applications under Enterprise Developer. You can then
deploy these applications back on the mainframe or migrate them onto one of the Micro Focus Linux, UNIX
or Windows-based production platforms.

Micro Focus offers Enterprise Developer with the following licensing options that unlock different
functionality:

Micro Focus
Enterprise
Developer
Connect

Enterprise Developer Connect is for customers looking to use modern and productive
Eclipse-based tooling to develop mainframe applications directly on the mainframe.
Close integration to mainframe configuration management systems and the ability to
easily customize the Eclipse-based IDE to include mainframe-based tools and
processes means developers can take full advantage of modern development tools
without having to learn new development processes.

Micro Focus
Enterprise
Developer

Enterprise Developer is for customers looking to develop and modernize mainframe
applications in a productive and modern Windows-based development environment,
targeted for deployment onto an alternate server platform. Developers have the choice
of either the Visual Studio or the Eclipse-based IDE and development and test tools
are provided for all target environments currently supported by Micro Focus.

Micro Focus
Enterprise
Developer for
IBM zEnterprise

Enterprise Developer for IBM zEnterprise gives customers the choice to develop
directly on the mainframe or under Windows. Mainframe applications can be
developed, maintained and modernized regardless of where they will be deployed,
either back onto the mainframe or onto an alternative server environment. Support is
provided for both the Visual Studio and Eclipse-based IDEs and for all the
development and test tools for every target environment currently supported by Micro
Focus - including z/Linux, AIX and x86 environments. Enterprise Developer for IBM
zEnterprise combines all the capabilities of Enterprise Developer Connect and
Enterprise Developer.

Full mainframe integration and the Application Workflow Manager are only available in
the Eclipse-based IDE.

In addition, this document contains information on workflow modelling extensions in the section Enterprise
Developer for IBM zEnterprise Workflow Modelling Extensions .

Note: The Enterprise Developer Personal Edition option is not available with this release. You can use
the Personal Edition with Enterprise Developer 2.1 Update 1 - you can register for it on the Enterprise
Developer Personal Edition section on the Micro Focus Web site.

Note:

• Mainframe Access Server is only available with an Enterprise Developer or with an Enterprise
Developer for IBM zEnterprise license and is not available with an Enterprise Developer Personal
Edition license.
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Compiling for
Enterprise
Server or for
Enterprise
Server 2012

Enterprise Developer for Visual Studio 2010 and Enterprise Developer for Visual
Studio 2012 each target a different version of the COBOL run-time system - COBOL
Server 2010 and Enterprise Server 2012 respectively.

Ensure that after you've edited the project in the preferred version of Visual Studio,
you compile your source code in that version of Enterprise Developer which targets
the version of the COBOL run-time in which you want your applications to run.

For example, if you build your application using Enterprise Developer for Visual Studio
2010 you cannot deploy the target files to Enterprise Server 2012; you must use
COBOL Server 2010.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Heartbleed Update - The OpenSSL library used in this product has been updated to the latest
version, 1.0.1i, to fix various vulnerabilities.

• Starting with the next product release, Micro Focus will no longer support Enterprise Developer for
Visual Studio 2010.

Important: Application executables that were compiled using earlier Micro Focus products must be
recompiled from the sources using Enterprise Developer. For more information, read the section
Upgrading to Enterprise Developer for Visual Studio 2010 in the product Help.
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Installation

System Requirements

Hardware Requirements
Enterprise Developer has the following requirements in addition to the requirements of Microsoft Visual
Studio. See the Visual Studio documentation for details of the Microsoft requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, it is recommended to have a minimum
of 2GB of RAM.

The disk space requirements are, approximately:

Windows

Platform Enterprise Developer Sentinel RMS License Manager

x86 Windows platforms 450MB 25MB

x64 Windows platforms 550MB 25MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

UNIX

The disk space requirements for Micro Focus Enterprise Developer Unix Components are approximately:

Platform Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

POWER running
AIX

414 1.66 828 33

HP IA 789 3.16 1580 61

System Z running
Red Hat Linux

354 1.4 708 34

x86-64 running
Red Hat Linux

372 1.48 744 40

SPARC running
Solaris

442 1.77 884 38

System Z running
SuSE SLES

359 1.44 718 34
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Platform Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

x86-64 running
SuSE SLES

377 1.51 754 40

Operating Systems Supported
Note: If you are using Enterprise Developer on a 64-bit operating system, you can produce either 32-
bit or 64-bit applications.

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:

• This product can be installed on earlier versions of Windows but it has not been tested on them.

Software Requirements

Windows:

Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components. Besides the software listed below, the
setup file also installs the 32-bit Java 6 Update 27.

Visual Studio IDE

Enterprise Developer requires:

• A full version of Microsoft Visual Studio 2010 or 2012 Premium, Professional, or Ultimate edition, or the
respective version of Microsoft's Visual Studio Integrated Shell.

In addition, Microsoft's Visual Studio 2010 Service Pack 1 (SP1) is required if you are installing
Enterprise Developer for Visual Studio 2010 - you can download it from the Microsoft Download Center.

Your preferred edition of Microsoft's Visual Studio must be installed before you start the Enterprise
Developer installation. If Visual Studio is not installed, the Enterprise Developer setup file installs the
Visual Studio Shell (this requires that your machine is connected to the Internet if you are installing
Enterprise Developer for Visual Studio 2010).

If you are installing Enterprise Developer for Visual Studio 2010 and your machine cannot be connected
to the Internet, you need to download Microsoft's Visual Studio 2010 and the Visual Studio 2010
Service Pack 1 (SP1) on a machine that has Internet connection, and then copy the installer to your
machine. Visual Studio 2010 and SP1 must be installed before you install Enterprise Developer.

Note:

• Microsoft Visual Studio Express Edition is not supported.
• You can download the Visual Studio Integrated Shell from the Microsoft Download Center. If

you choose to install the Shell, ensure you run the installer to complete the installation - run
vsintshell.enu.exe from the location where you installed the download.

• Microsoft Windows SDK is required if you are using the Visual Studio Shell. See the Microsoft
Download Center and search for Windows SDK.
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• Microsoft .NET Framework 4.0. This is included with the above versions of Visual Studio.
• Microsoft .NET Framework 4.5. This is included with Visual Studio 2012.

Note:

• The Visual Studio feature project round-tripping requires Visual Studio 2010 Service Pack 1 is
required if you are using Enterprise Developer for Visual Studio 2010 and Enterprise Developer for
Visual Studio 2012 on the same machine.

• When building a native COBOL project that contains resources, you must replace the
cvtres.exe in the bin and bin64 directories of your Enterprise Developer installation with the
version of the file which gets installed with Visual Studio 2010 SP1. You can download Service
Pack 1 for Visual Studio 2010 from the Microsoft Download Center.

UNIX/Linux:

These are the software requirements for Micro Focus Enterprise Developer Unix Components:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• On Red Hat 6.x and Red Hat 7, you must have the following operating system libraries installed:

All Enterprise Developer products
glibc-*.x86_64
glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
libstdc++-*.x86_64
libstdc++-*.i686

Additional libraries required to use
the core_on_error runtime variable

gdb - the gdb packages (for the GNU Project Debugger) can
be installed from the install media for your OS.

Additional libraries for Micro Focus
Enterprise Developer Unix
Components

glibc-devel-*.x86_64
glibc-devel-*.i686

In addition, on IBM System z (390), you must have the following operating system libraries installed:

Additional libraries for Micro Focus Enterprise Developer Unix
Components

glibc-devel-*.s390
glibc-devel-*.s390x

Visit the Red Hat Web site for more information.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• Oracle's Java Platform, Enterprise Edition (Java EE) 6 or Java 7 is required to execute COBOL JVM
code and for native COBOL and Java interoperability. The earliest supported release of Java 6 is 1.6
Update 27. You can download Oracle's Java EE from Oracle's Web site and install it anywhere on your
machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
1.6 is 1.6.0.13. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.6 is
Java 6.0.13. You can get the HP-UX Java JDK from HP's Web site.
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• You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

Other Requirements

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Enterprise
Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Windows
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file. The following information specifies the third-party software required for
each feature.

• Application server support for interaction with Enterprise Server on page 9
• COBOL on Windows Azure on page 10
• Java Development Kit (JDK) on page 10
• Database Access on page 10
• Database Access - COBSQL (Pro*COBOL) on page 11
• Database Access - OpenESQL on page 11
• Database Access - HCO for SQL Server (HCOSS) on page 12
• Database Access - HCO for DB2 LUW on page 14
• Database Access - SQL Option for DB2 on page 14
• Enterprise Server for .NET on page 14
• Micro Focus Rumba on page 15
• WebSphere MQ on page 15
• Windows Forms on page 15

Application server support for interaction with Enterprise Server

Back to Top

Java EE 5 and Java EE 6 are supported for the deployment of EJBs generated using the Interface Mapping
Toolkit, as follows:

• Java EE 5 includes support for EJB 3.0 and Java Connector Architecture 1.5
• Java EE 6 includes support for EJB 3.1 and Java Connector Architecture 1.6

The following Java application servers are supported using the following JDKs:
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Application Servers JDK (vendor) Java EE

JBoss 5 1.5/1.6 (Oracle) 5

JBoss 6 1.6 (Oracle) 6

Oracle WebLogic 10 1.5 (Oracle) 5

Oracle WebLogic 12 1.6/1.7 (Oracle) 6

IBM WebSphere 7.0 1.5 (IBM) 5

IBM WebSphere 8.0 1.6 (IBM) 6

IBM WebSphere 8.5 1.6/1.7 (IBM) 6

COBOL on Windows Azure

Back to Top

Windows Azure requires additional software. See the Microsoft Windows Azure web site for a full list of the
required software, but the following is a summary of the main prerequisites:

• Windows 7, Windows Vista® SP1 or higher, or Windows Server® 2008
• Visual Studio's Visual Web Developer feature
• Windows Azure Tools version 2.1 for Visual Studio - this includes the Windows Azure SDK
• Internet Information Services (IIS) 7.0 - this must be installed and enabled, with ASP.NET, which is not

enabled by default

Java Development Kit (JDK)

Back to Top

Native COBOL and
Java Interoperability

Oracle's Java Platform, Enterprise Edition (Java EE) 6 or Java 7 is required to
execute COBOL JVM code and for native COBOL and Java interoperability. The
earliest supported release of Java 6 is 1.6 Update 27. You can download Oracle's
Java EE from Oracle's Web site and install it anywhere on your machine.

Compiling Java Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is
required for compiling Java.

Interface Mapping
Toolkit (IMTK)

Restriction: This feature applies only when the Enterprise Server feature
is enabled.

The JDK is required for generating Java interfaces from the Interface Mapping
Toolkit or the imtkmake command.

Java Beans Your Java client needs to be compiled with JDK 1.6 or greater.

EJBs Use the same JDK vendor and version that is used by the
application server.

After installing the JDK, you need to set up your Java environment.

Database Access

Back to Top

Before you can use Enterprise Developer to develop and deploy SQL applications that use COBSQL, HCO
for DB2 LUW, HCO for SQL Server (HCOSS), SQL Option for DB2, or OpenESQL, ensure any third-party
software prerequisites are installed and the environment is set properly.
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Database Access - COBSQL (Pro*COBOL)

Back to Top

Note: COBSQL (Pro*COBOL) is supported for native COBOL only.

Availability Feature/Platform 32-bit 64-bit

x86-64 running
Windows

X X

XA Switch Module The Oracle XA switch module is provided for COBSQL (Pro*COBOL), and is
available on the same platforms as are indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the
responsibility of the RDBMS vendor, rather than Micro Focus. Certification
information can be found within the relevant Oracle documentation. If you have an 
Oracle MetaLink account, document # 43208.1 provides details of all language
compilers certified by Oracle for use with their precompilers.

Preprocessors COBSQL supports the following database preprocessors:

• Sybase Open Client Embedded SQL/COBOL Version 11.1 or later
• Oracle Pro*COBOL Version 11.1 (11gR1) or later
• Informix Embedded SQL/COBOL Version 7.3 or later

Compiling On x86 and x86-64 platforms, when compiling with COBSQL for use with Oracle,
do not use the COBSQL directive option NOMAKESYN, since this directive results
in COMP host variables, and on Intel platforms these are incompatible with the
native byte order expected by Oracle.

Back to Top

Database Access - OpenESQL

Availability Feature/
Platform

Native COBOL
32-bit

Native COBOL 64-bit PL/I 32-bit

x86-64 running
Windows

X X X

XA Switch
Modules

The ODBC One-phase Commit and the SQL Server XA switch modules are provided
and are available on the same platforms as are indicated in the Availability section
above.

To build the SQL Server XA module, you must have the Windows Software
Development Kit (SDK) installed for your version of Windows.

Native
COBOL, .NET
Managed
COBOL, and PL/I

• OpenESQL supports access to relational databases using ODBC 3.0-compliant
drivers

• Refer to your driver vendor's documentation to determine whether your driver is
suitable for use with OpenESQL

.NET Managed
COBOL

• OpenESQL has been tested against the following ADO.NET data providers:

• Microsoft provider for SQL Server
• Microsoft provider for Oracle
• IBM DB2
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• Oracle Data Provider for .NET (ODP.NET)
• OleDb
• Managed ODBC .NET providers

• Dynamic SQL using the SQL Descriptor Area (SQLDA) is not currently supported
for OpenESQL applications compiled with the SQL(DBMAN=ODBC) directive.

SQL CLR
Integration

The following software is required to use the SQL CLR integration feature, which is
specifically for the development and deployment of COBOL stored procedures under
Microsoft SQL Server.

Projects based on the SQL CLR Database Project template require:

• Visual Studio Professional 2010, Premium 2010, or Ultimate 2010
• SQL Server 2008 R2 targeting .NET CLR v2.0 frameworks (2.0, 3.0, 3.5)

Projects based on the SQL Server Database Project template require:

• All of the following:

• Visual Studio Shell 2010, Visual Studio Professional 2010, Premium 2010, or
Ultimate 2010

• Subsequent installation of:

• Visual Studio 2010 SP1 (for any previously installed edition of Visual Studio
2010)

• Microsoft SQL Server Tools (SSDT SDK)
• Any of the following:

• SQL Server 2008 R2 targeting .NET CLR v2.0 frameworks (2.0, 3.0, 3.5)
• SQL Server 2012 targeting .NET CLR v4.0 framework (4.0, 4.5) or .NET CLR

v2.0 frameworks (2.0, 3.0, 3.5)
• SQL Server Azure targeting .NET CLR v4.0 framework (4.0, 4.5) or .NET CLR

v2.0 frameworks (2.0, 3.0, 3.5)

SQL CLR
Integration

The following software is required to use the SQL CLR integration feature, which is
specifically for the development and deployment of COBOL stored procedures under
Microsoft SQL Server.

Projects based on the SQL Server Database Project template require:

• Either of the following:

• Visual Studio Shell 2012 and Microsoft SQL Server Tools (SSDT SDK)
• Visual Studio Professional 2012, Premium 2012, or Ultimate 2012

• Any of the following:

• SQL Server 2008 R2 targeting .NET CLR v2.0 frameworks (2.0, 3.0, 3.5)
• SQL Server 2012 targeting .NET CLR v4.0 framework (4.0, 4.5), or .NET CLR

v2.0 frameworks (2.0, 3.0, 3.5)
• SQL Server Azure targeting .NET CLR v4.0 framework (4.0. 4.5) and also .NET

CLR v2.0 frameworks (2.0, 3.0, 3.5)

Important: The SQL CLR Database project template is not supported with
Visual Studio 2012. Projects based on the SQL CLR Database project template
are automatically upgraded to use the SQL Server Database project template
when opened in Enterprise Developer for Visual Studio 2010.

Database Access - HCO for SQL Server (HCOSS)

Back to Top
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Microsoft SQL
Server

SQL Server 2008 R2 or later, Developer or Enterprise Editions, including Microsoft SQL
Server Management Studio.

Database
Migration

• Microsoft .NET Framework 4.0
• Microsoft SQL Server Integration Services - available with the Microsoft SQL Server

editions listed above
• Microsoft OLE DB Provider for DB2, available in the SQL Server 2008 R2 or later

Feature Pack

Note: Be sure to configure the OLE DB Provider to connect to the mainframe.
See your Microsoft documentation for details.

• Mainframe DB2

Note:

• We support only the mainframe DB2 versions that are currently under IBM
support.

• If you intend to develop applications on your local machine, but deploy
applications to a SQL Server database on a remote machine, you can install
SQL Server Native Client 10.x (or later) for ODBC connectivity on your local
machine instead of installing SQL Server. For SQL Server 2014 connectivity,
you can install Microsoft ODBC Driver 11.0 for SQL Server. For information on
configuring a deployment machine, see the section Deploying Native
Applications below.

Application
Migration

ADO.NET
applications

ADO.NET applications require either of the following
combinations:

• SQL Server 2008 R2 and SqlClient Data Provider in .NET
Framework 3.5

• SQL Server 2012 and SqlClient Data Provider in .NET
Framework 3.5 or 4.0 (4.0 is preferred)3.5, 4.0, or 4.5 (4.x is
preferred)

COBOL Stored
Procedures

See the requirements specified in the SQL CLR Integration
section under Database Access - OpenESQL in this topic.

Deploying
Native
Applications

Development
Machine

• Enterprise Developer for Visual Studio 2010
• If SQL Server 2008 R2 or 2012 is not installed, you must have

Microsoft SQL Server 2008 R2 or 2012 Native Client installed.
For SQL Server 2014, you must have Microsoft ODBC Driver
11.0 for SQL Server.

Development
SQL Server
Machine

SQL Server 2008 R2 or later

Note: This can be the same machine as the development
machine, but is not required to be

Deployment
Machine

• Enterprise Server or Enterprise Test Server installed
• If SQL Server 2008 R2 or 2012 is not installed, you must have

Microsoft SQL Server 2008 R2 or 2012 Native Client installed.
For SQL Server 2014, you must have Microsoft ODBC Driver
11.0 for SQL Server.

If you want to bind your application from the deployment machine,
install the following software in addition:

• Microsoft .NET 3.5 framework, or later
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• SQL Server 2008 R2 or later System CLR Types
• SQL Server 2008 R2 or later Shared Management Objects

Deployment
SQL Server
Machine

SQL Server 2008 R2 or later

Note: This can be the same machine as the deployment
machine, but is not required to be

Database Access - HCO for DB2 LUW

Back to Top

Availability Feature/
Platform

Native COBOL
32-bit

Native COBOL 64-bit PL/I 32-bit

x86-64 running
Windows

X X X

XA Switch Module The DB2 XA switch module is provided and is available on the same platforms as
are indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the
responsibility of the RDBMS vendor, rather than Micro Focus. You can find IBM
document certification information for DB2/COBOL applications within the IBM
Information Center for DB2, in the topic Support for database application
development in COBOL.

Preprocessor HCO for DB2 LUW supports the following database preprocessors:

• IBM DB2 LUW Version 9.5 or later
• IBM DB2 Connect Version 9.5 or later

Host Compatibility
Option (HCO)

Host Compatibility Option requires that you have one of the following software
products installed and configured:

• IBM Database Connect
• IBM DB2 LUW Personal Edition or DB2 Express-C
• DB2 LUW Workgroup or Enterprise Edition

You must also install the DB2 Application Development Client (formerly called DB2
SDK) or you will not be able to compile any DB2 programs.

Database Access - SQL Option for DB2

Back to Top

Feature/Platform 32-bit

x86-64 running Windows X

XA Switch Module XDB XA switch modules are provided and are available for the Windows x86-64 32-
bit platform.

Enterprise Server for .NET

Back to Top

• Microsoft .NET Framework 4.0
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• Microsoft SQL Server 2008 R2. For beta or development installations, SQL Server Express 2008 R2 is
sufficient.

You can download Microsoft's SQL Server from http://www.microsoft.com/sqlserver/en/us/get-sql-
server/try-it.aspx.

• A TN3270 terminal emulator. Micro Focus Rumba is supplied with this product.

Note: You also need to enable IIS and some additional Windows features. Read the Quick Start
section in your Enterprise Server for .NET help for further instructions on how to set up your operating
environment.

Micro Focus Rumba

Back to Top

• On Windows 8, in order to install Micro Focus Rumba you must have the Microsoft .NET Framework 3.5
Service Pack 1 installed.

WebSphere MQ

Back to Top

IBM WebSphere MQ version 7 and later.

Windows Forms

Back to Top

• Microsoft Visual Studio is required for using the Interface Mapping Toolkit (IMTK) to generate Windows
Forms and ASP.NET Web site test clients.

• Microsoft Internet Information Service (IIS) is also required for generating Windows Forms test clients.

Additional Software Requirements for Micro Focus
Enterprise Developer Unix Components
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file. The following information specifies the third-party software required for
each feature.

• Application server support for JVM COBOL on page 15
• Application server support for interaction with Enterprise Server on page 16
• Java Development Kit (JDK) on page 17
• Database Access on page 17
• Database Access - COBSQL (Pro*COBOL) on page 17
• Database Access - OpenESQL on page 18
• Database Access - HCO for DB2 LUW on page 19
• WebSphere MQ on page 15

Application server support for JVM COBOL

Back to Top

The following application servers are supported using the following JDKs:

Application Servers JDK version Containers support version

Tomcat 7.0.39 1.6 / 1.7 Servlets 2.5
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Application Servers JDK version Containers support version

JBoss 7.1.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 on AIX 6.1 1.6.0 SR10 FP1 / 1.7 Release 1 Servlets 2.5

WebSphere 8.5 1.6 / 1.7 Servlets 2.5

WebSphere 8.5 on AIX 6.1 1.6.0 SR10 FP1 / 1.7 Release 1 Servlets 2.5

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK 1.6
is 1.6.0.13. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.6 is
Java 6.0.13. You can get the HP-UX Java JDK from HP's Web site.

• On all other platforms, you need Oracle's JDK. The earliest supported release of Oracle's JDK 1.6
is 1.6.027. You can download Oracle's JDK from Oracle's Web site.

Application server support for interaction with Enterprise Server

Back to Top

Java EE 5 and Java EE 6 are supported for the deployment of EJBs generated using the Interface Mapping
Toolkit, as follows:

• Java EE 5 includes support for EJB 3.0 and Java Connector Architecture 1.5
• Java EE 6 includes support for EJB 3.1 and Java Connector Architecture 1.6

The following Java application servers are supported using the following JDKs:

Application Servers JDK (vendor) Java EE

JBoss 5 1.5/1.6 (Oracle) 5

JBoss 6 1.6 (Oracle) 6

Oracle WebLogic 10 1.5 (Oracle) 5

Oracle WebLogic 12 1.6/1.7 (Oracle) 6

IBM WebSphere 7.0 1.5 (IBM) 5

IBM WebSphere 8.0 1.6 (IBM) 6

IBM WebSphere 8.5 1.6/1.7 (IBM) 6

The availability of resource adapters for these Application Servers differs between UNIX platforms. The
following table indicates where support is available for each platform:

Feature/
Platform

JBoss 5 JBoss 6 Websphere
7.0

Websphere
8.0

Websphere
8.5

Weblogic 10 Weblogic 12

AIX 6.1 on
RS6000

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

HP/UX 11.31
on Intel IA64

32- and 64-
bit

32- and 64-
bit

64-bit 64-bit 64-bit 32- and 64-
bit

32- and 64-
bit

Red Hat EL
6.2 on
IBM390

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit
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Feature/
Platform

JBoss 5 JBoss 6 Websphere
7.0

Websphere
8.0

Websphere
8.5

Weblogic 10 Weblogic 12

Red Hat EL
5.5 on AMD
Opteron

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

Solaris 11 on
AMD
Opteron

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

Solaris 10 on
SPARC

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

SuSE SLES
11 SP1 on
IBM390

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

SuSE SLES
11 on AMD
Opteron

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

Java Development Kit (JDK)

Back to Top

Compiling Java Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is
required for compiling Java.

Interface
Mapping Toolkit
(IMTK)

Restriction: This feature applies only when the Enterprise Server feature is
enabled.

The JDK is required for generating Java interfaces from the Interface Mapping Toolkit
or the imtkmake command.

EJBs Use the same JDK vendor and version that is used by the application
server.

After installing the JDK, you need to set up your Java environment.

Database Access

Back to Top

Before you can use Enterprise Developer to develop and deploy SQL applications that use COBSQL, HCO
for DB2 LUW, or OpenESQL, ensure any third-party software prerequisites are installed and the
environment is set properly.

Database Access - COBSQL (Pro*COBOL)

Back to Top

Note: COBSQL (Pro*COBOL) is supported for native COBOL only.

Availability Feature/Platform 32-bit 64-bit

x86-64 running Red Hat
Linux

X X
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Feature/Platform 32-bit 64-bit

x86-64 running SuSE
Linux

X X

IBM System p running
AIX

X X

IBM System z running
SuSE Linux

X X

Itanium running HP-UX X X

x86-64 running Solaris X X

SPARC running Solaris X X

XA Switch
Module

The Oracle XA switch module is provided for COBSQL (Pro*COBOL), and is
available on the same platforms as are indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the responsibility
of the RDBMS vendor, rather than Micro Focus. Certification information can be
found within the relevant Oracle documentation. If you have an Oracle MetaLink
account (http://metalink.oracle.com), document # 43208.1 provides details of all
language compilers certified by Oracle for use with their precompilers.

Preprocessors COBSQL supports the following database preprocessors:

• Sybase Open Client Embedded SQL/COBOL Version 11.1 or later
• Oracle Pro*COBOL Version 11.1 (11gR1) or later
• Informix Embedded SQL/COBOL Version 7.3 or later

Compiling On x86 and x86-64 platforms, when compiling with COBSQL for use with Oracle, do
not use the COBSQL directive option NOMAKESYN, since this directive results in
COMP host variables, and on Intel platforms these are incompatible with the native
byte order expected by Oracle.

Executing On HP-UX, to execute an application precompiled using Pro*COBOL (or COBSQL)
after you have created a callable shared object of Oracle DBMS routines, you need
set an environment variable, LD_PRELOAD, to point to the Oracle client callable
shared object, for example:

LD_PRELOAD=$ORACLE_HOME/libdir/libclntsh.so       
export LD_PRELOAD

where libdir is:

• lib32 for 32-bit environments
• lib for 64-bit environments.

A script is available that creates an executable run-time system or a callable shared
object containing Oracle support. You can find the script in the Micro Focus
Knowledge Base article titled Building and executing Pro*COBOL applications on
UNIX.

Database Access - OpenESQL

Back to Top

18 | Installation

HTTP://METALINK.ORACLE.COM


Availability Feature/
Platform

Native COBOL
32-bit

Native COBOL 64-bit PL/I 32-bit

x86-64 running
Red Hat Linux

X X X

x86-64 running
SuSE Linux

X X X

IBM System p
running AIX

X X X

IBM System z
running SuSE
Linux

X X

Itanium running
HP-UX

X X

x86-64 running
Solaris

X X

SPARC running
Solaris

X X X

Native COBOL • OpenESQL supports access to relational databases using ODBC 3.0-compliant
drivers

• Refer to your driver vendor's documentation to determine whether your driver is
suitable for use with OpenESQL

Database Access - HCO for DB2 LUW

Back to Top

Availability Feature/
Platform

Native COBOL
32-bit

Native COBOL 64-bit PL/I 32-bit

x86-64 running
Red Hat Linux

X X X

x86-64 running
SuSE Linux

X X X

IBM System p
running AIX

X X X

IBM System z
running SuSE
Linux

X X

Itanium running
HP-UX

X

x86-64 running
Solaris

SPARC running
Solaris

X X X
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XA Switch Module The DB2 XA switch module is provided and is available on the same platforms as
are indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the responsibility
of the RDBMS vendor, rather than Micro Focus. You can find IBM document
certification information for DB2/COBOL applications within the IBM Information
Center for DB2, in the topic Support for database application development in
COBOL.

Preprocessor HCO for DB2 LUW supports the following database preprocessors:

• IBM DB2 LUW Version 9.5 or later
• IBM DB2 Connect Version 9.5 or later
• On SPARC running Solaris, 64-bit is supported in IBM versions 10.1 or later

Host Compatibility
Option (HCO)

Host Compatibility Option requires that you have one of the following software
products installed and configured:

• IBM Database Connect
• IBM DB2 LUW Personal Edition or DB2 Express-C
• DB2 LUW Workgroup or Enterprise Edition

You must also install the DB2 Application Development Client (formerly called DB2
SDK) or you will not be able to compile any DB2 programs.

WebSphere MQ

Back to Top

IBM WebSphere MQ version 7 and later.

Installing Enterprise Developer for Visual Studio

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

You can download Enterprise Developer for Visual Studio 2012 from the Micro Focus SupportLine Web site
and from the Product Updates section.

Product Co-Existence
• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same

machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.
• Enterprise Developer is available in different IDE variants, each one of which is targeted by one specific

variant of the development product:

• Enterprise Server - the deployment environment for COBOL applications created with Enterprise
Developer for Visual Studio 2010 or Enterprise Developer for Eclipse

• Enterprise Server 2012 - the deployment environment for COBOL applications created with
Enterprise Developer for Visual Studio 2012

You can only deploy applications to the specific variant of Enterprise Server that is targeted by the
Enterprise Developer variant used to build the applications. For example, if you build your application
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using Enterprise Developer for Visual Studio 2012, you can only deploy the target files to Enterprise
Server 2012. The application will not run in Enterprise Server.

Installation restrictions and requirements
Before starting the installation you should consider the following:

• If, when you install Enterprise Developer for Visual Studio 2010, the machine does not have Microsoft
Visual C++ 2010 Redistributable Runtime already installed, it is installed as required by Enterprise
Developer. The installation of Microsoft Visual C++ 2010 Redistributable Runtime adds a number
of .dll files, without digital signatures, into the winsxs directory.

• If, when you install Enterprise Developer for Visual Studio 2012, the machine does not have Microsoft
Visual C++ 2012 Redistributable Runtime already installed, it is installed as required by Enterprise
Developer. The installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll
files, without digital signatures, into the winsxs directory.

• If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation. Also, the Visual Studio Help Viewer must not be opened.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) from an existing product is stopped and uninstalled. On
Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open an  Enterprise Developer command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Installing and Licensing Micro Focus Rumba
The Enterprise Developer setup file includes Micro Focus Rumba 9.2 which you can install as an optional
component. The license for Enterprise Developer will also license all components of Rumba (for example,
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Rumba Office, Rumba for Mainframe, Unix, AS400, and the TN3270 mainframe display within Enterprise
Developer).

Note: Micro Focus Rumba versions 8.3 or later provide integration with Enterprise Developer where
you can use a Rumba TN3270 Mainframe Display within the IDE in order to run applications.

Installation considerations:

• If you are installing Enterprise Developer 2.2 Update 2 onto a machine that does not have Rumba
installed, it is recommended that you select the Rumba option when you start the installation. This
installs all of the components of Rumba including the one you need to establish a mainframe 3270
connection (Rumba for Mainframe).

• Installing Rumba 9.2 as part of this release of Enterprise Developer will update any older version of
Rumba installed and licensed on your machine.

Note: Micro Focus recommends that you upgrade older versions of Rumba to the one installed
with Enterprise Developer. However, if you want to keep an older version of Rumba, you can
choose not to install Rumba when you start the Enterprise Developer 2.2 Update 2 installation. In
this case, the TN3270 Mainframe Display will not be available for use from within Enterprise
Developer.

• If a version of Rumba more recent than version 9.2 is installed and licensed on your machine, you can
choose not to install Rumba as part of the Enterprise Developer 2.2 Update 2 installation. The TN3270
Mainframe Display provided with this version of Rumba may be supported within Enterprise Developer
but might not have been tested.

Installing as an Upgrade
This release will update existing installations of Enterprise Developer 2.2.

• Before installing this release as an upgrade to an existing installation of the previous version 2.2 of the
product, you must uninstall any HotFixes of 2.2. This is to avoid some problems that might result in files
not being installed.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Installing
Note:

• If installing Enterprise Developer for Visual Studio 2010, check Software Requirements for
information about what and how to install if your machine is not connected to the Internet.

• Before installing, check Installation Restrictions and Requirements.
• See Installing as an Upgrade first for important information when upgrading an existing installation

of Enterprise Developer.
• This version of the product is a full install.

To install this product:

1. Run the edvs2010_222.exe (edvs2012_22.exe when installing the product for Visual Studio 2012
file and follow the wizard instructions to install the prerequisite software and the product.

The installer installs Enterprise Developer, Enterprise Server for .NET, and offers to install Micro Focus
Rumba. The setup file will also install any missing prerequisite software as listed in the topic Software
Requirements.
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Note:

• When the installation has completed, on some editions of Windows you might receive a notification
that Visual Studio 2012 has compatibility issues. This is a Microsoft's known problem. To resolve it,
follow the instructions in the notification for obtaining help online, or download the KB2781514
update for Visual Studio 2012 from the Microsoft Download Center.

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Developer but you can install it if you wish.

Enterprise Developer Installation Options
To install Enterprise Developer you run edvs2010_222.exe which contains a number of product .msi
files (Windows Installer packages). When run, edvs2010_222.exe performs some initial system checks
then sequentially installs the .msi files.

Note: The following applies to edvs2012_22.exe when installing the product for Visual Studio 2012.

edvs2010_222.exe can take a number of parameters, enabling you to specify a number of different
types of installation:

• Standard Installation

Format:
edvs2010_222.exe

Summary:
Full installation including License Manager and Enterprise Developer. During installation you can
specify options including the location to which the components are installed.

• Non-interactive Installation

Format:
edvs2010_222.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
edvs2010_222.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
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edvs2010_222.exe /q InstallFolder=d:\otherdirectory

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
Enterprise Developer is installed to d:\otherdirectory.

Format:
edvs2010_222.exe /q RumbaCheckbox=1

Summary:
Full installation of Enterprise Developer and of the Micro Focus Rumba component. All components
are installed non-interactively with no user interface.

To see what parameters you can use, execute the following from the command line:
edvs2010_222.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

Microsoft Terminal Server
You can use this product with Microsoft Terminal Server but note that a separate end-user license is
required for each user who accesses it, even if the product is running on a single machine. See your End
User License Agreement.

Microsoft Terminal Server is an environment for running multiple instances of a single-user product. It is not
a platform where a single-user product can be made to perform as a multi-user product.

To install onto a terminal server:

• Log on to the physical terminal server with a user ID that has administrator privileges.
• Use Control Panel > Programs and follow the instructions on the screen.

When you install the product on Microsoft Terminal Server or similar terminal software, do not execute
more than one installation at the same time.

When you install Microsoft Terminal server, you must assign a unique port address to each user. Then the
very first time that each user logs into Enterprise Developer and starts the terminal server, they should:

1. Select Options > Project > Port address for Web Server.
2. Type in the assigned port address.

This is necessary because the default port address for the Web server is 80. Once this has been allocated
to the first user, when the next user attempts to start the Web server, the software recognizes that this port
is in use and rejects the attempt. Consequently each user requires an individual port address.

Installing from a Server
There are two methods for installing this product on users' machines using a server. You can:

• Copy the product onto the server and then use Setup under control of a third-party software distribution
package, such as Microsoft's Systems Management Server (SMS), to install the product onto multiple
users' machines.

This method of installation and the associated file are not supported by Micro Focus. They are provided
on an "as is" basis and have not been tested in any form. You can use them at your own discretion.

• Install onto the server. Then users run Setup to install from the server onto their own machines.

24 | Installation



Both methods give you control of what options the user can install and mean you do not have to send the
installation media to every user, as they install from the server instead.

Windows Compatibility Mode
In Windows Vista and Windows Server 2008, if you have problems starting Enterprise Server instances
using the Micro Focus Enterprise Server Administration HTML GUI, ensure that none of the Enterprise
Server program files are configured to use a Windows compatibility mode. You can check for compatibility
modes by examining the file properties for the program file using Windows Explorer:

1. Open the Properties dialog box for the file.
2. Click the Compatibility tab.
3. Ensure that Run this program in compatibility mode for is not checked.
4. Click Show settings for all users and ensure that Run this program in compatibility mode for is not

checked.
5. Click OK on both dialogs to update the file properties.

Verify that <install-dir>\base\bin\mfds.exe is not set to run in a compatibility mode.

• For 32-bit Enterprise Server, check bin\cas*.exe and bin\mfcs.exe
• For 64-bit Enterprise Server, check bin\win64\cas*.exe and bin\win64\mfcs.exe.

After Installing
You are now ready to run Enterprise Developer. From the Windows taskbar click Start > All Programs >
Micro Focus Enterprise Developer > Enterprise Developer for Visual Studio nnnn.

Note: The Start menu is not available on Windows 8 and Windows Server 2012. You use the Start
screen to invoke programs.

Note: For applications created with earlier Micro Focus products or earlier versions of Enterprise
Developer, note the following:

Database
Access

Managed applications using SQL(DBMAN=ODBC) that were compiled in
Enterprise Developer 2.1 Update 1 must be recompiled in Enterprise Developer
2.2 Update 2.

Existing
Applications

Application executables that were compiled using earlier Micro Focus products
must be recompiled from the sources using Enterprise Developer. For more
information, read the section Upgrading to Enterprise Developer for Visual Studio
2010 in the product Help.

Open PL/I
Compiler

Important: If you are installing this release as an upgrade to Enterprise
Developer 2.2 Update 1, after the upgrade you must rebuild any applications that
are compiled using the –zp1 option.

The behavior of the –zp1 option has been reverted to that of versions of Enterprise
Developer earlier than 2.2 Update 1, with an additional correction relating to Char
Varying data items.

The behavior has been restored to that in Enterprise Developer versions earlier than
2.2 where, when compiling with –zp1, all parameters are treated as unaligned. (In
Enterprise Developer 2.2 Update 1, the behavior when compiling with –zp1 was to not
treat parameters as if unaligned).

When using the –zp1 compiler option, all Character Varying data items are now treated
as if unaligned. In previous versions of Open PL/I, for Character Varying data items,
the –zp1 unaligned requirement was applied only to structure members and
parameters.

Installation | 25



To illustrate the change, consider the following example:

zptest: proc options(main); 
 
   dcl 1 st1, 
     2 c char, 
     2 x(4) char(7) var init ('a', 'xx', 'yyy', 'zzzz'); 
 
   dcl y(4) char(7) var init ('a', 'xx', 'yyy', 'zzzz'); 
 
   dcl sub entry ((4) char(7) var); 
 
   call sub (x); 
 
   call sub (y); 
 
end; 
 
sub: proc (z); 
 
   dcl z(4) char(7) var; 
 
   dcl i fixed bin(31); 
 
  do i = 1 to hbound(z); 
      z(i)  = 'x'; 
  end; 
 
end; 

Where:

• For x and z, each char (7) var item is 7 plus 2 bytes which equals 9 and then
multiplied by 4 equals 36.

• If y were aligned on half-word by default, each array element is half-word aligned
and each equals 10 bytes (9 + 1 pad byte), and the total size equals 40 bytes.

• At call sub (x), the calling argument and parameter are matched.
• At the call sub (y), the y element size (10 bytes) is mismatched against the

parameter z element size (9 bytes) due to –zp1. This is incorrect and causes
unexpected program behavior.

Due to this correction of treating all Char Varying data items as if unaligned when using
–zp1, the size of CHAR VARYING arrays now differs from previous versions of Open-
PL/I. For example:

   dcl X(4) char(7) var; 
 
   Put skip list (size(X))  /* size is 36 bytes vs. 40 bytes in 
previous versions of Open-PL1 */ 

Please refer to the Start Here and Product Information sections in your product Help. Here, you will find
information on getting started including tutorials and demonstration programs.

Note:

• The first release of Visual Studio 2010 has a browser-based help system, Microsoft Help Viewer
1.0, which does not include an index for the locally-installed help. Navigation of the content is only
available using the table of contents and Search and the help contents for the Help system does
not expand and collapse in the same way as previous Help systems.

• If you have problems trying to view the Micro Focus help, ensure that the Visual Studio Help
Library is pointing to local help. From the Visual Studio menu click Help > Manage Help Systems
> Choose online or local help and check the I want to use local help button.

26 | Installation



• Visual Studio 2010 SP1 provides an upgrade of the help system, Microsoft Help Viewer 1.1, which
provides a stand-alone help viewer with an index and a fully expandable table of contents.

• If you do not want to install Visual Studio 2010 SP1, you can install some third-party tools that
enable the index or the fully expanding table of contents. For more information, see the topic Help
on Help.

• To view the help in Visual Studio 2012, ensure that the Visual Studio Help Library is pointing to
local help. From the Visual Studio menu click Help > Set Help Preferences > Launch in Help
Browser.

• For full details of the Visual Studio 2012 Help system, see the locally installed Microsoft Help
Viewer 2.0 Help, which is available from Help menu in the IDE.

• On Windows 8 and Windows Server 2012, an issue with Microsoft Help Viewer 2.0 and Internet
Explorer's security being turned on can cause the Help content to be displayed as raw HTML
code. To resolve the issue, you need to turn off the Internet Explorer Enhanced Security
Configuration (IE ESC) for both administrators and users. Check the Microsoft Windows help for
more information on how to do this.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Installing Micro Focus Enterprise Developer Unix
Components

Note:

• Micro Focus Enterprise Developer Unix Components is only available with an Enterprise
Developer or Enterprise Developer for IBM zEnterprise license and is not available with an
Enterprise Developer Personal Edition license.

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing
Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

These are the steps to install this product:
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1. Give execute permissions to the setup file:

chmod +x setup_entdev_2.2_update2_platform

2. Run the installer from the Process User ID login:

./setup_entdev_2.2_update2_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_2.2_update2_platform -installlocation="full path of new 
location"

Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ],
where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file -
for example, -ESsysLog="/home/esuser/logs". The default location is /var/
mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command
line - for example, -EDadminID="esadm". The default user ID is the one that runs the
installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the -
skipsafenet option, which skips the installation of SafeNet:

./setup_entdev_2.2_update2_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file
and install Sentinel RMS server manually.
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1. To set up your product, execute:

. /opt/microfocus/EnterpriseDeveloper/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA

After the application installation is complete you can install the license silently by executing the following
commands:

If you have access to the Internet
and an authorization code

Run the following as root:

cd /var/microfocuslicensing/bin
./cesadmintool.sh -authorize AuthorizationCode

If you don't have access to the
Internet but have a file from Micro
Focus that contains the license
string

Run the following as root:

cd /var/microfocuslicensing/bin
./cesadmintool.sh -install FileName

where FileName is the name of the text file that contains all the
license strings to be used.

UNIX and Linux Installer Issues

Installing on
Linux

On Linux, the 32-bit version of Java is required to install and use Enterprise Developer
for Eclipse. When you start the installation, if the 64-bit version of Java is already
installed on your Linux machine, you might not be able to install Enterprise Developer.
This is a known issue with the Oracle Java installers for Linux which prevent you from
installing both the 32-bit and the 64-bit versions of Java on the same machine. To work
around this problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle
Web site.

• Untar the distribution into a location different from the one used for the 64-bit Java
version. For example, untar in /usr/local/java32 and not in /usr/local/
java.

• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is
used to install and run Enterprise Developer.
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License
Infrastructure
Installer

• On some Solaris platforms, you can receive the following error message when
SafeNet license server needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory

To resolve this issue, wait for the installation to complete and then perform the
following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

• Note: The following information applies when you are installing on Red Hat
Enterprise Linux (RHEL) 7. (RHEL 7 is a beta version and support for it is a
technical preview only).

Certain configuration changes in RHEL 7 (such as the /etc/inittab file no longer
available) required a change in the MF SafeNet license installer for this platform and
the way you can manually manage the licensing service.

By default, the MF SafeNet licensing service is still configured so that it starts
automatically when starting your machine. Only on RHEL 7, you must use the
systemctl command available with the OS if you need to override the default
behaviour – for example, if you do not want run the MF SafeNet licensing service at
start-up or if you do not want the service to automatically start when you are
configuring trace levels.

1. Create a file, MFSafeNet.service, in /usr/lib/systemd/system/ with the
following contents:

----------- start of /usr/lib/systemd/system/
MFSafeNet.service -----------
    [Unit]
    Description=Micro Focus SafeNet licensing daemons. 
    Documentation=http://supportline.microfocus.com

    [Service]
    Type=forking
    ExecStart=/var/microfocuslicensing/bin/startboth.sh
    ExecStop=/var/microfocuslicensing/bin/stopboth.sh
    Restart=no

    [Install]
    WantedBy=multi-user.target
-----------  end of /usr/lib/systemd/system/
MFSafeNet.service  -----------

2. Use the systemctl command to manage the SafeNet service:

[ asroot ] systemctl option MFSafeNet

Where some of the values that option can take are:

reenable Installs the SafeNet service.

is-enabled Checks the status of the SafeNet service. Does not require root
privileges.

start Starts the SafeNet service.

stop Stops the SafeNet service.

restart Restarts the SafeNet service.

disable Disables the SafeNet service so it does not start when the
machine is booted.
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enable Enables the SafeNet Service so it starts when the machine is
booted.

For more information about systemctl, refer to the help available with the RHEL
OS.

License
Server

You need to configure the computer hostname to ensure the license server will start
properly.

To avoid performance issues, "localhost" and the computer hostname must not both be
mapped to IP address 127.0.0.1. You should only map "localhost" to IP address
127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts
file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Installing Mainframe Access Server
Note: Mainframe Access Server is only available with an Enterprise Developer or with an Enterprise
Developer for IBM zEnterprise license and is not available with an Enterprise Developer Personal
Edition license.

Introduction

The installation process for Mainframe Access Server (MFA) uses a single FTP operation to transfer all of
the mainframe software into a partitioned data set that you pre-allocate. When this transfer is complete, the
remaining installation activities are all done on the mainframe. You customize and submit the pre-built
FRESTORE job to restore the product data sets from the uploaded files and then continue with
customization steps to create an operational Mainframe Access Server.

Requirements

• IBM TCP/IP 4.0, or Interlink TCP/IP 3.1 or higher
• Two APPLIDs, two TCP/IP ports
• Availability of APF security authorization support personnel
• Access to a network share with acceptable space for source and data, as well as the ability to access

the IP address and ports used to access MFA
• The following installation-specific variable information:

Variable Description

drive

userid TSO user-ID for FTP to your mainframe

pswd TSO password for the FTP user-ID

your.mainframe.name TCP/IP host name or IP address of your mainframe
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Variable Description

prodhlq A NEW high level qualifier that will be assigned for all
Host Connectivity data sets when the new Mainframe
Access product is installed. These are NOT existing
product data sets, but rather brand new files that you
will be creating for this base version.

Important: The installation of a new version of MFA creates new product run-time data sets before
the upgrade is applied. Any existing Host Connectivity 3.01 libraries remain intact, and can be
used for fallback. If you prefer to retain your former production library names and re-use your
existing prodhlq, rename your old libraries beforehand.

Make a note of the maintenance level of your current Mainframe Access Server. Messages
MFM0001I and MFM0014I on the syslog and XDBOUT sysout data set show the maintenance
level at startup. You may need to know what level you are upgrading from when you complete post-
installation customizations for this upgrade.

Install Mainframe Access Server

In the instructions that follow, the information that you must provide is shown as one of the variable names
from the table of information in the previous section. For example, if your high-level qualifier (prodhlq) value
is MY.MFA, then substitute MY.MFA for prodhlq.

Follow these steps to load Mainframe Access Server:

1. Download the installation file from the link in your Electronic Product Delivery email and extract its
contents to a directory on the PC.

2. On the mainframe, allocate a new partitioned data set named prodhlq.UPLOAD to receive the uploaded
files. Use the following data set characteristics for this upload library:

DSORG=PO                   <=== PDS (partitioned data set)
RECFM=FB                   <=== record format fixed and blocked
LRECL=80                   <=== 80 character record size
BLKSIZE=3120               <=== 3120 character block size
SPACE=(3120,(3500,500,50)) <=== allocate blocks (BLKS) size 3120
                                3500 primary blocks
                                500 secondary blocks
                                50 directory blocks

3. On the PC, issue the following FTP commands. The actual text of the FTP prompts and responses that
you see may differ slightly from those shown in this example.

a. Start FTP:

C:\>ftp your.mainframe.name
Connected to your.mainframe.name.
220-FTPD1 IBM FTP CS/390 VxRy at YOUR.MAINFRAME.NAME, hh:mm:ss
220 Connection will close if idle for more than 5 minutes.
User (your.mainframe.name:(none)): userid
331 Send password please.
Password: pswd
230 userid is logged on. Working directory is "userid.".

b. Change the working directory on the mainframe to be the upload library that you allocated:

ftp> cd 'prodhlq.UPLOAD'
250 The working directory "hlq.UPLOAD" is a partitioned data set.

c. Set file transfer type to binary:

ftp> binary
200 Representation type is Image

d. Set FTP prompting off to transfer all files without interruption:

ftp> prompt
Interactive mode Off.
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e. Transfer all files from the extracted \Upload directory to members in the prodhlq.UPLOAD library:

ftp> mputdrive:\upload\f*
200 Port request OK.
125 Storing data set prodhlq.UPLOAD(Fxxxxxxx)
250 Transfer completed successfully.        
ftp: xxxx bytes sent in x.xx seconds (xxx.xx Kbytes/sec)
.
.
.

f. When mput has transferred all files the ftp> prompt appears. End the FTP connection:

ftp> quit
221 Quit command received. Goodbye.        

g. On the mainframe, verify that all files transferred successfully and that for each Fxxxxxxx file in the
\Upload directory there is a corresponding member in the prodhlq.UPLOAD data set. There should
be 10 members, F1 through to F9 and FRESTORE.

4. On the mainframe, edit member FRESTORE in the upload library, prodhlq.UPLOAD. Follow the
instructions in that member to customize the JCL and then submit that job to restore the product
libraries from the uploaded files and populate your new product runtime libraries.

5. Start Mainframe Access Server.

After installation

Since the program libraries can change between versions, it is necessary to either create new procedures,
or back up the old procedures, and at least modify the DSNQUAL=prodhlq within your MFA sample started
task procedures as provided by Micro Focus. The prodhlq.LOADLIB and prodhlq.SASC.LINKLIB must both
be authorized.

Verify successful maintenance application by checking the Mainframe Access Server startup message:

MFM0001I: Mainframe Access V4.00 (BASE ) is active

The "(BASE )" indicates the product maintenance level. Also check for "V4.00" in the Mainframe Access
Data Connect server startup message:

MFA303I MFA/DATACONNECT V4.00 - BASE COPYRIGHT (C) 1987-2012 MICRO FOCUS...

When you are satisfied with the new version installation you may delete the UPLOAD data set from your
system.

New parameters and members in the CNTL samples data set

The following updated members are found in the CNTL data set.

MFA sample MFA started task

MFAS *new* sample MFAS started task for Data Connect

MFAAS sample MFAAS application server started task

MFAVTAM sample MFA VTAM definitions

PARMS sample PARMS for MFA started task

PARMSAS sample PARMSAS for MFAAS started task

SERVERS sample SERVERS configuration for MFA

UPQUICK configuration notes

If you are migrating from Host Connectivity 3.01 WebSync 10 or earlier, you may want to retain your
existing CNTL members from your current version as an installation test. You can simply copy the existing
MFA started task JCL and change the STEPLIB to reference the new product libraries. You will however
need to modify the MFAS started task JCL since the module names for Data Connect have been changed
to allow co-residence within the same authorized library as MFA.

Installation | 33



Review the Change Log in each of the new members. Read the documentation for any new parameters in
the Readme and in the updated Mainframe Access Administrator's Guide. Add these new parameters and
other changes to your working copies. If necessary, customize the new parameters for your installation.

Once you are satisfied with the operation of Mainframe Access, you can consolidate the configuration
settings into the new high-level qualified CNTL members.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Enterprise Developer
does not automatically uninstall Enterprise Server for .NET, the Micro Focus License Administration
or any of the prerequisite software.

Enterprise Server for .NET must be uninstalled before you remove Enterprise Developer. To
completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• The Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

• Micro Focus Server\Performance\Active Servers
• Micro Focus Server\Performance\PerfIniFile

UNIX

Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper2.2.sh script in the $COBDIR/bin
directory.
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Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• The Enterprise Developer Personal Edition option is not available with this release. You can use
the Personal Edition with Enterprise Developer 2.1 Update 1 - you can register for it on the 
Enterprise Developer Personal Edition section on the Micro Focus Web site.

• Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license
To buy a license for Enterprise Developer, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Enterprise
Developer help.

To start Micro Focus License Administration

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8 and Windows Server 2012, you use the Start screen to invoke programs.

Installing licenses

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:
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1. Start Enterprise Developer.
2. Click Help > Micro Focus Product Help > Product Licensing to open the Product Licensing dialog

box.
3. Ensure I have a full Enterprise Developer Team Edition license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click Authorize to install the license.

You should see a dialog box with a confirmation that the licenses have been installed successfully.

If you have an authorization code

Authorizing your product when you have an Internet connection
Note: This topic only applies if you have an authorization code.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code.

This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
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10.Click Install Licenses.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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New Features in Enterprise Developer 2.2
Update 2

This release provides enhancements in the following areas:

Visual Studio

Enterprise Developer provides enhancements in the following areas:

• Call Hierarchy - support for the Call Hierarchy window has been enhanced and it now shows types and
members across the entire solution.

• Debugging enhancements - includes enhanced support for the Autos windows for native and managed
COBOL, support for querying EBCDIC data in managed code, and support for the standard visualizers
for data items and groups in native COBOL.

• Expanded Copybook View (only supported in Visual Studio 2012 and Visual Studio 2013) - now
supports Intellisense, collapsing and expanding of outlining regions, and code snippets.

• Find All References - you can now configure the scope of the Find All References command. The
default behavior is to search for references in the current COBOL project and now, you can enable Find
All References to search for matches in all managed COBOL projects that are part of your solution.

• Net Express Project Import wizard - now includes a number of usability enhancements.
• Run-time configuration - you can now use the application configuration file, Application.config, in

native COBOL projects to set all run-time tunables.

Character Set Enhancements

The following character sets, available using the MFCODESET environment variable, have been enhanced
or added in this release:

• Thai Extended (0066) - new
• Korean (0082)
• Simplified Chinese (0086)
• Traditional Chinese (0886)

There are also a number of double-byte character sets that are now capable of mixed single-byte and
double-byte character conversion; see the definition of MFCODESET in Environment Variables in
Alphabetical Order for more information.

Code Analysis

Enterprise Developer can produce the following COBOL reports:

• Dead Code - finds unreferenced items or any piece of code that can't be reached during execution.
• Unreferenced Data - finds any data items that are not explicitly referenced in the Procedure Division of a

program.
• Undeclared Procedures - finds any procedures that are referred to but not defined.
• Copybook Structure - displays the hierarchy of any copybooks defined in a program.
• Program Statistics - provides general information, such as number of source code lines, number of data

items, and size of data items.
• Unexecuted Procedures - finds any procedures that are defined but not referred to.

Database Access

The following new features are available in database access support:
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COBSQL In Visual Studio:

• Pro*COBOL support - you can now select and configure the Pro*COBOL COBSQL
preprocessor for compiling COBSQL applications on the SQL tab in the project's
properties.

• KEEPCOMP - the new KEEPCOMP directive resolves COMP/COMP-5 issues with
Oracle applications on little-endian platforms.

HCO for DB2
LUW

This release introduces GEN-HV-FROM-GROUP - a new DB2 ECM compiler directive
option, that generates host variables for all elementary data items when a multiple-level
group variable is used in a FETCH or singleton SELECT DB2 statement.

HCO for SQL
Server
(HCOSS)

This release provides the following new HCOSS features:

• DATE/TIME formatting - the OpenESQL Configuration Utility now supports DATE/
TIME formatting for HCOSS batch utilities.

• Multi-row INSERT - supports a multi-row INSERT statement.
• Sample applications - Enterprise Developer for Visual Studio includes the following

new mainframe HCOSS sample applications:

• Array Insert - demonstrates how array inserts work with SQL Server using
mainframe DB2 syntax.

• Multiple Result Sets - demonstrates how to create a SQL Server SQL CLR stored
procedure with multiple result sets and how to access them from a client program
using mainframe DB2 syntax.

• Sample application - Enterprise Developer for Eclipse includes the following new
mainframe HCOSS sample application: the Array Insert sample demonstrates how
array inserts work with SQL Server using mainframe DB2 syntax.

OpenESQL This version provides the following new OpenESQL features:

• Support for SQL Server 2014.
• New SQL Compiler directive options:

• DETECTDATE=SERVER - resolves host variables alignment with column data
types in an SQL table.

• GEN-HV-FROM-GROUP - generates host variables for all elementary data items
when a multiple-level group variable is used in a FETCH or singleton SELECT SQL
statement.

• Sample applications - the following native COBOL SQL sample applications are new
with this version:

• Get Diagnostics - demonstrates how to use GET DIAGNOSTICS EXEC SQL calls
to get diagnostic information from various DBMSs.

• LOB Data Types - Demonstrates how to INSERT and SELECT LOB data in a
native application using various DBMSs.

SQL Option
for DB2

Support for the following has been added in this version:

• DSNUTILB LOAD LOG=NO option
• RID scalar function
• XML data type via XDB Link to mainframe DB2

XA switch
modules

The following XA switch module updates are available in this version:

• Oracle switch module:

• Supports User Impersonation when statically registered.
• Enables you to specify which XA resource definitions use User Impersonation.
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• Now compiled with one source file, rather than two.
• SQL Server switch module:

• Enables you to specify which XA resource definitions use User Impersonation.
• Now compiled with one source file, rather than two.

Enterprise COBOL 5.1 compatibility

There have been a number of enhancements to make this version of Enterprise Developer more
compatible with Enterprise COBOL 5.1.

Note: These enhancements are available under both DIALECT(MF) and DIALECT(ENTCOBOL).

• The following phrases have been added to the XML GENERATE statement:

• NAME
• SUPPRESS
• TYPE

• The following intrinsic functions have been added:

• ULENGTH
• UPOS
• USUBSTR
• USUPPLEMENTARY
• UVALID
• UWIDTH

• A number of reserved and context-sensitive reserved words have been added; see the topics Reserved
Words Table and Context-sensitive Words Table for complete lists.

External Call Interface (ECI)

Enhancements to the ECI include:

• The ECI for Java clients is no longer restricted to the 32K Commarea. You can now transfer virtually
unlimited containers of any size in a channel to a CICS server program. See ECI Java Interface for
more information.

• Java support for IBM's implementation of ECI, which, in turn, uses the Micro Focus implementation.
• A ECI RA for WebSphere; however, in this release, no IMTK tooling is provided for servlets or JSP.

External Security Facility (ESF)

The Enterprise Server External Security Facility (ESF) now supports caching the results of some security
queries. This can improve the performance of enterprise server instances and of the MFDS when they are
configured to use external security.

To enable caching, you need to set non-zero values for the Cache limit (maximum size of the cache) and
Cache TTL (Time To Live, or how long before a cached result expires) settings on the MFDS Security tab,
the Default ES Security tab, or on the Security tab for an individual enterprise server. (Currently, the
cache settings for Security Managers have no effect; you need to set cache parameters on one of the three
Security pages mentioned earlier.)

For more information, see http://supportline.microfocus.com/examplesandutilities/doxygen/caching.html.

Enterprise Server for .NET

Enhancements are available in the following areas:
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• Azure deployment - the Azure deployment now deploys to the latest worker role guest OS version,
Windows Server 2012 R2, which has the latest .NET frameworks (versions 4.0, 4.5 and 4.5.1) installed.

• CICS/JCL Subsystem Started Task Manager - Subsystem Started Task Manager (SSTM) provides JES
functionality within a CICS region and enables the region to submit batch work to a JES region. The
JES functionality is equivalent to that of a task started under z/OS and must support CICS spooling.

CICS spooling enables spooling files to the JES region or submitting JCL jobs. CICS spooling does this
using its internal reader or using the SPOOLOPEN, SPOOLWRITE and SPOOLCLOSE APIs.

• Diagnostics - the diagnostic collection process now provides more detailed diagnostic information.
• JCL initiator node affinity - node affinity enables a particular initiator to be associated with a particular

machine and execute certain types of work only on that machine. An example of this is running a
particular job on a machine with specific third-party software installed, for which only one license exists.

• MQ Series support - the WebSphere MQ .NET managed code client only provides a class library
interface and not the traditional MQI (MQ programming interface). The MQI interface is now
implemented within Enterprise Server for .NET which enables you to run applications that utilize the
MQI without any code changes.

• System administration - this release includes two new views, Sessions view and Request view, that
enable system administrators to see which sessions are attached to a region, which tasks are active
and which ones are queued.

Enterprise Server for .NET provides a better integration with Visual Studio as follows:

• Associating projects with regions - support for associating your managed CICS or JCL projects with a
region is available from within Visual Studio. This is to provide the ports required for JVCL submission
and for TN3270 integration.

• Submit JCL from within Visual Studio - for a project that is associated with a JCL-enabled region, you
can now submit JCL files that are part of the project directly from within Visual Studio.

• Embedded TN3270 Rumba mainframe display - you can now use the TN3270 Rumba mainframe
display embedded in Enterprise Developer to run managed CICS applications from within Visual
Studio.

• Viewing the console log in Visual Studio - you can now display the console log of a region associated
with your project in the Output window in Visual Studio.

IMS Connect

This release now supports Java IMS Connect messages except when also using the IBM-supplied
HWSJAVA0 I/O exit.

PL/I General Enhancements

Enhancements are provided in the following areas:

• Attributes - the PL/I DECLARE statement now supports the OPTIONAL attribute as part of the
parameter-descriptor list or as an attribute in a parameter declaration. This provides an improved
functionality and a greater language compatibility for customers looking to migrate applications from
z/OS environments.

• Built-in functions - the PL/I Compiler and run-time system now support the PRESENT and OMITTED
built-in functions which provides an improved functionality and a greater language compatibility if you
are looking to migrate applications from z/OS environments.

• Compound operators - the PL/I macro preprocessor now supports the compound operators += , -=, *=,
and /= within macro assignment statements.

• Error handling - you can now use the EXEC CICS HANDLE ABEND check which provides a consistent
error handling technique for PL/I programs running under CICS that is consistent with error handling on
the mainframe. EXEC CICS HANDLE ABEND determines error handling for programs running under
CICS. Conditions detected by CICS cause an abend if established using EXEC CICS HANDLE ABEND,
and PL/I ON units do not get control. If EXEC CICS HANDLE ABEND is not established, CICS defines
that the action taken will be as defined by CICS, which normally leads to a transaction abend.

42 | New Features in Enterprise Developer 2.2 Update 2



• PL/I data structures - this release provides enhanced support for PL/I data structures in the Data File
Tools. You can now easily generate a PL/I structure map (.str) from within the IDE, and the Data File
Tools can then use to generate a formatted layout for a PL/I data file. This enables you to see what is in
each field within a PL/I Data File Record, and to modify the records in a logical way without having to
know the offset, length and raw format of the data item.

Rumba 9.2

This release of Enterprise Developer includes Micro Focus Rumba 9.2 which you can optionally install as
part of the setup process. The license for Enterprise Developer will license all components of Rumba.

Tunables

This release includes the following new tunable:

• reduce_java_signals - specifies the options that are passed to a JVM when mixing Java and COBOL.
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Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

ASP.NET It is not possible to run ASP.NET Web Sites or Web Services on a production machine
(one that has Micro Focus Enterprise Server installed) without an additional setup.
This is because the production machine does not contain development tools such as
the COBOL Compiler. To workaround this, you need to do the following steps:

1. Compile the site prior to deploying it using the Publish Web Site command in
Visual Studio.

2. Edit the .asmx file of the Web service project or the .aspx file of the Web site and
delete the Language="COBOL" statement.

3. Edit the Web.config file with a text editor and delete the line which contains:
<compiler language="COBOL"...

4. Ensure that a .NET Server license is installed using Apptrack.

CICS • An EXEC CICS DELAY statement may sometimes produce a difference of one
second.

COBOL
Watchpoints

The debugger ignores a COBOL watchpoint that is hit if there is no statement
following the statement that modifies the data on which that watchpoint is set.

Documentation • In Visual Studio 2012, clicking Help > Micro Focus Product Help > Product
Documentation results in the message "Cannot find requested topic on your
computer". If you see this message, click Micro Focus Enterprise Developer 2.2 for
Visual Studio 2012 in the Contents tab to display the documentation as expected.

• If you install Enterprise Developer for Visual Studio 2012 and its documentation is
not available in the Microsoft Help Viewer, perform the following steps:

1. In Visual Studio 2012, click Help > Add and Remove Help Content.
2. Choose the Manage Content tab.
3. Check the Disk radio button, then navigate to the folder containing the

Enterprise Developer for Visual Studio 2012 documentation. By default, this is
C:\Program Files (x86)\Micro Focus\<product name>\help.

4. Select helpcontentsetup.msha and click Open.
5. In the content list, click Add next to the Enterprise Developer entry.
6. Click Update.
7. Click Yes on the User Account Control and Microsoft Help Viewer 2.0 dialog

boxes to enable the update to continue.

The documentation for Enterprise Developer for Visual Studio 2012 is added to
the Microsoft Help Viewer.

Note:

This problem only occurs if you install Enterprise Developer for Visual Studio
2012 while documentation for Visual Studio 2012 is being downloaded or
updated, which typically happens when you install Visual Studio 2012 or run
it for the first time.
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Enterprise
Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled
enterprise servers.

Expanded
Copybook View
(in Visual Studio
2012)

• When you add a COPY statement in a COBOL program and then show it in
Expanded Copybook View, the line for the copybook statement is read-only. If you
then perform an Undo in the COBOL program, the COPY statement is removed
while the contents of the copybook is still shown in the program.

• Replace All does not work inside the Expanded Copybook View
• For copybooks with file extensions that are not traditionally associated with COBOL

you must first add the file extension to the list of known copybooks extensions in
Tools > Options > Text Editor > File Extensions before you can show them in
Expanded Copybook View.

ICETOOL
Emulation

ICETOOL emulation for managed code is not available in this release.

Installation • Before installing this release as an upgrade to an existing installation of the
previous version 2.2 of the product, you must uninstall any HotFixes of 2.2. This is
to avoid some problems that might result in files not being installed. This is
required only on Windows.

• Before installing this release as an upgrade, ensure you create a back-up of your
Enterprise Server configuration. To do this, on the Enterprise Server Administration
home page, click Export and then select Export Enterprise Server configuration
and Security Manager definitions. This creates a backup folder in the c:
\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import
on the Enterprise Server Administration home page.

• When installing this product for Visual Studio 2010, if you already have Visual
Studio 2010 Isolated Shell with Service Pack 1 (SP1) installed, you might
experience problems with starting Visual Studio after the installation. This is a
Microsoft issue relating to the Integrated Shell (installed as part of the Micro Focus
product installer) overwriting some Visual Studio SP1 components. To resolve the
issue you need to repair Visual Studio 2010 SP1.

Micro Focus
Rumba

On versions of Windows Vista and later, Enterprise Server listens only on the IPv4
loopback address (127.0.0.1). As a result, an attempt to connect to localhost with a
TN3270 emulator such as Micro Focus Rumba may fail. To work around this issue, in
your emulator's configuration use 127.0.0.1 in preference to localhost or your host
machine's name.

Native COBOL On Windows XP, when building a native COBOL application in Visual Studio, a dialog
may pop up with error "Unhandled exception at 0xc0006866 in cobol.exe:
0xC0000005: Access violation reading location 0xc0006866)". This is caused by
Symantec antivirus runtime protection. To resolve this, you need to apply the following
fix from Symantec: http://www.symantec.com/business/support/index?
page=content&id=TECH97280&locale=en_US.

Resource
Adapters

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic
may fail with a ClassCastException. To work around this issue, you need to deploy
mfcobol-xa.rar first, then need to undeploy this file and deploy the local one,
mfcobol-localtx.rar. If there are issues deploying using the WebLogic GUI, you
can use the command line. If there are issues with this as well, try reducing the length
of the command (for example, by moving the file to a location with a shorter path).

Visual Studio
IDE

• In the properties of a managed project, the Application page currently allows you
to select any of the static methods in the application as a Startup object. This is
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incorrect. You should always set only the first static method or the program name
as a Startup object in order for the project to build.

• Using Call Hierarchy locks the source files currently opened in the editor. To work
around this problem, you need to trigger a syntax check - for example, by making a
small change to one of the open files.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• .NET CICS (General)
• Compiler
• Compiler Front-end
• Documentation
• Enterprise Server
• File Handling - External File Handler
• J2EE Connector
• MTO: CICS Communications
• MTO: IMS DB
• MTO: IMS MFS
• MTO: JCL MVS
• MTO: JCL Utils
• Open PL/I Compiler
• Open PL/I Debugger

.NET CICS (General)

Back to the list

• The data file location list in the region startup file now supports both on-disk and database folders – for
example, c:/project/bin/debug and sql://(dbinst)/VSAM/?folder=FOLDER1;type=folder.

When searching for a file, CICS will check in all of the provided locations in the order specified. Files
that are accessed using fileshare or the catalog are not affected by these changes and continue to work
like they did before. You can configure how CICS locates the underlying data files using a new set of
properties. When using the CICS Resource File Editor to explore the ResourceDefinitions.config file,
FCTs now include a File Location Overrides section with the following properties:

• Filename – specify a filename or a filename with an extension (for example, ACCTFIL.DAT) that
CICS will search for instead of using the FCT name.

• File Extension –specify a file extension. The FCT name must be used as the file name.
• Folder – specify where CICS should search for files.
• If this is set to the absolute path to a folder on your machine or to a database folder, CICS only

searches for files in that folder and does not use the data file locations.
• If this is set to a relative path (such as "/subfolder1/subfolder2/"), CICS applies that relative path to

each of the data file locations in which it searches for the file.

Note: Previously, the Folder property was called Path and had to be set to the full absolute path to
the data file. These three properties are compatible with the native Enterprise Server and can be
enabled in any combination.

Previously, in order for CICS to locate a file in the database, you had to set the Format property to
RDBMS and the Path property of an FCT to the name of the datastore. This is no longer required.

Instead, you need to add the datastore folder that contains the file either to the data file locations or to
the Folder property in the File Location Overrides section in the FCT properties. You can still use the
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RDBMS format value as a hint to configure CICS to create the file (for example, using CFCR) in the
database and not on disk.

If you install this release, you must modify any FCTs that were using the old Path property. For example:

If you previously had:

FCT ( Name=fct1 Path="c:\folder\file1.dat" )

This must be converted to: FCT ( Name=fct1 FileName="file1.dat" )

And the data file location, c:\folder\, must be added to the region startup file.

2780059 (1094576)

Compiler

Back to the list

• When using the HOSTRW directive with the mainframe dialect, Report Writer will now produce the full
range of ASA control characters and will emulate mainframe print files.

2697615 (1094527)

Compiler Front-end

Back to the list

• Fixed Binary (p<=7) is now an 8-bit, signed, 2's complement binary integer by default.

Documentation

Back to the list

• The default setting for the MFALLOC_PCFILE environment variable has changed; the default is now set
to Y, which means that when cataloguing a file that has a DCB attribute of DSORG=PS, a physical file is
created for it if one does not exist. Previously, the default was set to N, which meant that a file was not
created.

2697571 (1094370)

Enterprise Server

Back to the list

Starting with this release, IMSCONFG.DAT is no longer used for configuring enterprise servers. Instead,
you need to use environment variables to control the following fields:

Field Environment Variable

LANG=PL/I PCB address lists ES_IMS_PLI_INDIRECT_PCBADDR=D|Y|N

Where:

D
Dynamic (default) use indirect
PCB address list when PSB
language is PL/I and main
program is PL/I.

Y
Always use indirect PCB
address list if PSB language is
PL/I.

N
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Field Environment Variable

Never use indirect PCB
address list.

IBM Platform ES_IMS_IBMPLATFORM=M|D

Where:

M
MVS (default)

D
DOSVS Required by some
DOS/VS customers.

Secondary Index Sparse exit language ES_IMS_SPARSE_EXIT_LANG=C|A

Where:

C
COBOL

A
Assembler

Not set (default)
Sparse exits disabled

File Handling - External File Handler

Back to the list

• The ES_IMS_TLOG_FLUSH environment variable is now deprecated. To control TLOG flushing, use
the following environment variable: ES_IMS_DB_TLOG_WRITETHRU=0|1

0 Forces the flushing of TLOG buffers to disk on COMMIT only (default)

1 Forces the flushing of TLOG buffers to disk on all database I/O

To control database flushing, use the following environment variable: ES_IMS_DB_COMMIT_FLUSH=0|
1

0 Forces the flushing of database buffers to disk on CLOSE only (default)

1 Forces the flushing of database buffers to disk on COMMIT only

Depending on the number of database updates, the frequency of COMMITs, and other concurrent
computer activities, use of these environment variables could cause significant performance
degradation.

2784949 (1095190)
• The use of the environment setting MFJ_INPUTDS_ERROR=N has been extended so that an input file

for a JCL step is now considered as optional and you no longer receive an error when the file is missing.

2784622 (1095971)

J2EE Connector

Back to the list

• The listSystem.properties file in package com.ibm.ctg.client was missing documentation for some
sections.

(606556)
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MTO: CICS Communications

Back to the list

• In CRTE mode, the transactions are now run using the correct userid if the user has signed on after
running CRTE.

2663890 (1091979)

MTO: IMS DB

Back to the list

• The NODCX mfims dbdgen directive has been added to enable you to compile DBD source without
executing data capture exit routines contained in the DBD source. Previously, data capture exit routines
contained in the DBD source but that were not found during compilation were ignored. The new default
behavior is to process all data capture exit routines unless NODCX has been specified.

2579600 (1084675)

MTO: IMS MFS

Back to the list

• All existing IMS Global Physical Terminal edit routines (DFSGPIX0) in use must be recompiled with
charset EBCDIC instead of charset ASCII.

(606142)

MTO: JCL MVS

Back to the list

• Following the detection of an unrecoverable file status error on the casspool file, a message is displayed
on the console and an ACCEPT statement is issued. This stops processing, allowing you to fix the
underlying file problem, before continuing the job.

2651654 (1090287)

MTO: JCL Utils

Back to the list

• You can now activate support for the VSAM Shareoption for batch jobs and for CICS files that use a
catalog entry. For more details, see your product help.

2660651 (1091290)

Open PL/I Compiler

Back to the list

• Important: If you are installing this release as an upgrade to Enterprise Developer 2.2 Update 1,
after the upgrade you must rebuild any applications that are compiled using the –zp1 option.

The behavior of the –zp1 option has been reverted to that of versions of Enterprise Developer earlier
than 2.2 Update 1, with an additional correction relating to Char Varying data items. For a full
description of the –zp1 option, refer to the Open PL/I User’s Guide in the product help

This fix restores the behavior in Enterprise Developer versions earlier than 2.2 where, when compiling
with –zp1, all parameters are treated as unaligned. (In Enterprise Developer 2.2 Update 1, the behavior
when compiling with –zp1 was to not treat parameters as if unaligned).
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When using the –zp1 compiler option, all Character Varying data items are now treated as if unaligned.
In previous versions of Open PL/I, for Character Varying data items, the –zp1 unaligned requirement
was applied only to structure members and parameters.

To illustrate the change, consider the following example:

zptest: proc options(main); 
 
   dcl 1 st1, 
     2 c char, 
     2 x(4) char(7) var init ('a', 'xx', 'yyy', 'zzzz'); 
 
   dcl y(4) char(7) var init ('a', 'xx', 'yyy', 'zzzz'); 
 
   dcl sub entry ((4) char(7) var); 
 
   call sub (x); 
 
   call sub (y); 
 
end; 
 
sub: proc (z); 
 
   dcl z(4) char(7) var; 
 
   dcl i fixed bin(31); 
 
  do i = 1 to hbound(z); 
      z(i)  = 'x'; 
  end; 
 
end; 

Where:

• For x and z, each char (7) var item is 7 plus 2 bytes which equals 9 and then multiplied by 4
equals 36.

• If y were aligned on half-word by default, each array element is half-word aligned and each equals
10 bytes (9 + 1 pad byte), and the total size equals 40 bytes.

• At call sub (x), the calling argument and parameter are matched.
• At the call sub (y), the y element size (10 bytes) is mismatched against the parameter z

element size (9 bytes) due to –zp1. This is incorrect and causes unexpected program behavior.

Due to this correction of treating all Char Varying data items as if unaligned when using –zp1, the size
of CHAR VARYING arrays now differs from previous versions of Open-PL/I. For example:

   dcl X(4) char(7) var; 
 
   Put skip list (size(X))  /* size is 36 bytes vs. 40 bytes in previous 
versions of Open-PL1 */ 

2789213 (1095636)

Open PL/I Debugger

Back to the list

• Previously, the SRC list in the debugger only included the source filename without the path to the file. If
a source file did not exist in the current directory, the debugger could not find it using the filename as it
always expects a fully qualified filename. The SRC list now contains the fully qualified file name which
includes the path. Also, when changing the SRC or ENV values the source is updated correctly.

2783734 (1094988)
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• .NET Compiler
• .NET CICS (General)
• .NET ESQL Support
• .NET JCL (General)
• .NET Run-Time System
• Adis
• Assembler Compiler - HLL Macro Assembler
• CAS (COBOL App Server) General
• CAS Admin Console
• CAS Security
• CAS XA Switch modules
• CCI TCP/IP
• Compiler
• Codeset Support
• Data Tools Converter
• Data Tools Layouts
• Documentation
• Enterprise Analyzer Integration
• ES Cluster
• File Handling: External File Handler
• File Handling - Sort / JCL Sort
• HCO for Microsoft SQL Server
• MF Communications Server
• MF Directory Server
• MFA Server
• MFA SyncMon
• MFBSI
• MFIO
• MTO: CICS ECM/Preprocessor/Translator
• MTO: CICS Emulation
• MTO: CICS ESMAC
• MTO: CICS Supplied Transactions
• MTO: IMS DB
• MTO: IMS MFS
• MTO: IMS Other
• MTO: IMS TM
• MTO: JCL ESMAC
• MTO: JCL MVS
• MTO: JCL System Catalog
• MTO: JCL TSO
• MTO: JCL Utils
• MTO: JCL Utils - IDCAMS
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• NCG
• OO Run-Time System (32-bit)
• Open PL/I Compiler
• Open PL/I Debugger
• Open PL/I Macro Preprocessor
• Open PL/I Run-Time System
• Open PL/I SQL Preprocessor
• Run-Time System
• Setup Issues
• SQL: Cobsql
• SQL: DB2 ECM
• SQL: HCO for SQL Server
• SQL: OpenESQL
• Unassigned
• Visual Studio IDE
• Web Service Client
• XDB Server
• XDB: Problems not classed above
• XML syntax support runtime

.NET Compiler

Back to the list

• Comparisons between PIC N or PIC G items and ALL hex-literals are now working correctly.

2795393 (1096266)
• The CURRENT-DATE function, using reference modification with an implied length (e.g. FUNCTION

CURRENT-DATE(3:)), now behaves as expected when compiled to managed COBOL.

2788009 (1095691)
• In Managed COBOL only, an unreferenced elementary field of an "IS EXTERNAL" data item would not

be initialized by the INITIALIZE verb, even though the containing group item was referenced. This is
now working correctly.

2787385 (1095405)
• The performance of the .NET Compiler has been enhanced. Previously, programs that included multiple

pointers and comp-5 items with value clauses could take a long time to load. The use of the XML
preprocessor could lead to this condition, since it generates data of this type.

2784731 (1095278)
• Correct behavior is now being displayed when the INITIALIZE statement is used on DBCS data, where

the initializing literal is a single-byte alphanumeric.

2784714 (1095079)
• Exponentiation with a literal exponent of 2 (or multiple of 2) on a signed field is now working as

expected. In previous versions of the product, such an operation could lead to invalid code.

2784503 (1095063)
• Compatibility of SPZERO with native COBOL code has been improved in the following two cases: 1) If

a-9 = space (where a-9 is defined as pic 9(n) DISPLAY) With SPZERO on, this comparison will now
always yield a false result. 2) Move a-x to a-9 (where a-x is pic x(n) and a-9 is pic 9(n)) In the case
where a-x contains spaces, this move will now result in a-9 containing zeroes.

2676477 (1093768)
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.NET CICS (General)

Back to the list

• Under Enterprise Server for .NET, starting a debug SEP to debug transactions on a remote system
sometimes resulted in started tasks failing to get dispatched.

2789509 (1095732)
• In Enterprise Server for .NET, the generalized ERROR condition handler previously installed by a

HANDLE CONDITION was not being invoked when a condition that had otherwise not been handled
was raised by a CICS API.

2697875 (1094315)
• Leading and trailing spaces are no longer stripped from fields in BMS maps as part of a RECEIVE MAP

operation.

2693322 (1093717)
• When an Enterprise Server for .NET region is started, message CF0163 is logged to the Micro Focus

Server event log. In some cases, the region name and/or database instance details were missing from
this message. This has been fixed.

• Under Enterprise Server for .NET, a CICS CPMT NEWCOPY could result in SEP processes terminating
if any of the SEPs processing the request had previously performed JES region operations.

• Under Enterprise Server for .NET an RTS 114 error sometimes occurred following the invocation of
CICS INQUIRE TASK LIST when using the pointers returned by the SET or SETTRANSID options.

• A NullReferenceException occurred in Enterprise Server for .NET when an AMODE program invoked
the GET CONTAINER API specifying the SET option.

• Enterprise Server for .NET CICS no longer generates invalid terminal IDs and netnames after a large
number of transactions have been processed by a region.

• HTTP requests to Enterprise Server for .NET now consistently clean up their own sessions at
completion.

.NET ESQL Support

Back to the list

• When using OpenESQL for ADO.NET, the first execution of a statement for SQL Server no longer locks
the varbinary host variable sizes.

2791617 (1095920)
• The OpenESQL pre-compiler sometimes generated incorrect code if a PIC X(n) VARYING host variable

was used in a COBOL JVM project.

2787380 (1095934)
• The managed SQL run-time system now correctly handles variable string lengths for both 49-level

COMP fields and 49-level COMP-5 fields.

2782088 (1094793)
• The OpenESQL native ODBC wrapper used in managed applications would sometimes incorrectly set

index past the end of table before moving information to the table which resulted in a COBOL subscript
error.

2780447 (1094665)

.NET JCL (General)

Back to the list

• Creating an alternate index for a VSAM file from the Catalog View in the Enterpriser Server for .NET UI
no longer fails.
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.NET Run-Time System

Back to the list

• In managed code, multiple processes using the same input file in a SORT statement will no longer get
intermittent open failures.

2790155 (1095759)

Adis

Back to the list

• When using X"AF" function 81, screen attributes are now inherited correctly.

2782580 (1094878)
• Using an ACCEPT statement followed by a display of an OUTPUT RIGHT item and an ERASE EOL

item no longer causes a corruption of a screen section.

2695444 (1093924)

Assembler Compiler: HLL Macro Assembler

Back to the list

• The Assembler macro IDENTIFY was generating an invalid relocatable definition when the EPLOC=
operand was in a DSECT. The EPLOC= operand processing has been changed to use the load address
(LA) instruction which obtains a valid address for both CSECT resident symbols and DSECT resident
symbols.

CAS (COBOL App Server) General

Back to the list

• Using the INPUTMSG parameter for the XCTL and LINK commands is now working correctly.

2790518 (1095805)
• On user syncpoint, a 500-error no longer returns to the client if the application did not issue a WEB

SEND.

2780958 (1094671)
• When linking to a program with a channel, the current channel was not always honoured.

2779977 (1094556)
• Enterprise Server is not longer sending a FREEKB to the terminal at the end of a task when there is

more work pending for the terminal.

2691707 (1093544)
• You no longer receive an intermittent signal 11 in MFCS during shutdown.

CAS Admin Console

Back to the list

• When starting an enterprise server instance, the location of the work files may differ depending on
whether the instance was started using a browser or from the command line. See the documentation for
"system directory" in the topic "Server Instance Properties General".

2660616 (1090612)

CAS Security

Back to the list
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• The es-ldap-update.cmd script has been updated for the Enterprise Developer product line. The script is
used to install a sample set of security definitions when LDAP-based security is used with Enterprise
Server.

CAS XA Switch modules

Back to the list

• When using HCOSS, if a global temporary table is declared twice, the current transaction will no longer
be implicitly rolled back.

2780353 (1094629)
• An HCOSS problem where a cursor that was open for a global temporary table caused an EXEC CICS

SYNCPOINT ROLLBACK to fail has been fixed.

2779765 (1094542)
• Global temporary tables are now deleted after EXEC CICS SYNCPOINT ROLLBACK is executed.

2698545 (1094249)
• HCOSS concurrency issues with DECLAREd GLOBAL TEMPORARY TABLEs have been resolved. As

a result, in this release we no longer support user-defined (i.e., persistent) tables in the SESSION
schema.

2697852 (1094184)
• EXEC SQL RESET CONNECTION has been updated and is used to drop Global Temporary Tables at

the end of tasks.

2693269 (1093613)
• EXEC SQL SYNCPOINT has been updated and now correctly handles ON COMMIT actions for

DECLAREd global temporary tables.

2682648 (1093611)
• The XDB XA switch module has been enhanced to exploit CICS EOT processing for XDB transactions.

CCI TCP/IP

Back to the list

• CCITCP client connections could intermittently fail on some platforms due to transient errors in the
TCP/IP stack. CCITCP is now more aggressive at detecting and retrying client connections under these
conditions. This primarily affects COBOL Web services clients, some Enterprise Server command-line
utilities, and Fileshare clients.

2794263 (1096355)
• INT and CSO modules that use the Casfile API can now successfully connect to SSL-secured

Enterprise Server listeners.

2696022 (1094318)

Compiler

Back to the list

• Programs with a mainframe dialect that contain a paragraph declaration that is not preceded by a period
and that is previously referenced now compile as expected.

2793046 (1096112)
• Complex table VALUE syntax is now working as expected.

2792013 (1095954)
• Compilation no longer hangs when REPLACE and COPY REPLACING is active and the source code

has multiple lines ending in a comma.
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2791425 (1095905)
• READ and WRITE statements with the RM filehandler for files defined with the "RECORD VARYING

FROM 0 TO ..." syntax now behave as expected.

2785986 (1095385)
• An INSPECT CONVERTING statement on a subscripted sliding item now executes as expected.

2785328 (1095244)
• Setting the LINE-COUNT(2) Compiler directive on a project no longer causes the IDE to crash during a

background syntax check.

2784751 (1095114)
• Data items with DBCS characters which are defined as SQL data types are now processed correctly.

2783799 (1094976)
• The OSEXT and COPYEXT directives now work with quoted names (with or without spaces).

2780350 (604653)
• Compiling programs that use both the "WITH DEBUGGING MODE" and "IS INITIAL" clauses now

produces correct object code.

2779266 (1094498)
• Programs that use an external report file now execute as expected.

2698699 (1094352)
• The performance of the syntax constructs "SET ADDRESS OF .. TO ADDRESS OF ..." when using the

AMODE compiler directive has been improved.

2697051 (1094174)
• A MOVE of 'ALL <alphanumeric literal>' to a numeric display item is now correctly emulated under

DIALECT(RM).

2648551 (1089534)
• The IDE now correctly indicates the location of errors in multi-program source.

2541308 (1081744)
• Using Watch/Quick Watch on a data item with subscripts, where one of the subscripts is also

subscripted, now produces the correct results.

2463792 (1075281)
• A program that exceeds the system limit of 254 DETAIL groups for a report now receives an appropriate

error message "COBCH1692S Too many DETAIL groups specified for report".

2458349 (1096071)

Codeset Support

Back to the list

• The offset of input segments is now calculated correctly. In order to apply the fix, you must regenerate
the MFS source.

2695463 (1093948)

Data Tools Converter

Back to the list

• Converting a data file using record layouts will now report an error if a field within the selected record
layout exceeds the length of the data file record being converted.

2699617 (1094446)
• The GUI data file converter no longer terminates data item conversion prematurely when using a record

layout with an ODO data item.

Resolved Issues | 57



2692803 (1093839)

Data Tools Layouts

Back to the list

• Creating a record or a segment layout file no longer fails when the COBOL names contain double-byte
characters.

Documentation

Back to the list

• The name of the ES_IMSDB_ROLLBACK environment variable has been changed to
ES_IMS_ROLLBACK. Documentation now reflects this name change. Applications that use
ES_IMSDB_ROLLBACK are still compatible in this release.

2698601 (1094260)
• The documentation for the MFBSI CTF trace option has been corrected in the online help. It now reads:

mftrace.comp.mfbsi.emx#all = true

2693323 (1093631)
• The description for the MULTI-NESTED topic under DB2 Compiler Directive Options was incorrect.

2783274 (1094953)
• The BMS Painter .bmsx output file was not documented.

2782860 (1094902)
• The topic about the ILSMARTLINKAGE Compiler directive in the product help now includes information

about the get_Reference() method (JVM COBOL) and the .Reference property (.NET COBOL) that the
classes and types generated with ILSMARTLINKAGE produce. If you pass such a class or type as a
parameter to a program that receives it "by reference”, you need to use the "by reference" object by
specifying the get_Reference() method or .Reference property, respectively. This returns an object that
encapsulates the ILSMARTLINKAGE parameter so it be used with a method that is declared as "by
reference". You also need to use get_Reference() or .Reference with the RunUnit:Call() method.

2779516 (1094514)
• The setup file installs the product and any missing third party software, and will install the Java 7

Update 27. This information is now included in the Software Requirements section of the product help.

2785427 (1095199)
• The setup file installs the product and any missing third party software, and will install the .NET

Framework v4.0. This information is now included in the Software Requirements section of the product
help.

2672774 (1095057)
• The Release Notes for Enterprise Developer now state correctly that the supported versions of Visual

Studio are 2010 and 2012.

2785664 (1095227)
• The list of DLLs to copy to execute a stored procedure for DB2 in PL/I has been amended to include the

most current list.

Enterprise Analyzer Integration

Back to the list

• An issue with the DISPLAY ... LINE statement being unable to process expressions has been fixed.

ES Cluster

Back to the list
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• In a clustered configuration of Enterprise Server, on some platforms, MFCS could crash during startup
of an enterprise server instance due to attempting to process communications with the cluster manager
before initialization was complete.

File Handling - External File Handler

Back to the list

• An automatic close of a file opened in a container no longer causes a rollback.

2790362 (1095956)
• Previously, a file could be left with its integrity bit set to transactional if a process included a mix of

transactional and non-transactional opens and the last close of the file was a non-transactional one.

2785682 (1095657)
• The transaction log now correctly shows the timestamp for the prepare, commit and rollback operations.

2784948 (1095162)
• If a VSAM file is opened for an OUTPUT in a RANDOM/DYNAMIC access mode, the file virgin state is

changed to a non-virgin even if no records are written to it. If the file is opened for an OUTPUT in a
SEQUENTIAL access mode, its virgin state is retained.

2781975 (1094779)
• The MFALLOC_PCFILE environment variable now works as expected. Previously, it would be bypassed

when the ES_ALLOC_OVERRIDE environment variable was also specified.

2692290 (1093977)
• During Open OUTPUT of a VSE VSAM reusable file, with DISP=OLD, the file is no longer reset; the file

is opened in EXTEND mode.

2638640 (1089073)

File Handling - Sort / JCL Sort

Back to the list

• You no longer receive a SORTOUT RECFM 'VB' invalid message in situations where all the files are
'FB'.

2791516 (1096010)
• Edited PD fields no longer corrupt when MFJSSTRICTSORT is set.

2787824 (1095518)
• The FTOV parameter now works as expected when sorting data sets that specify RECFM=VBS.

2785814 (1095223)
• MFJTOOL now correctly displays ZD and PD fields.

2781909 (1094865)

HCO for Microsoft SQL Server

Back to the list

• When trying to compile an OpenESQL program with an invalid combination of the BIND ACCESS and
DBRMLIB Compiler directives, you now receive an error message.

2694907 (1093864)
• The HCOSS Data Transfer tool now supports SQL Server 2014. The executable for SQL Server 2014

for the command line is: mfdatatransferctlr14.exe.

MF Communications Server

Back to the list
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• - You no longer receive memory leaks in the MFCS process for CICS Web Interface servers.

- The MFCS process may fall behind in task processing if the Enterprise Server region handles a heavy
load of quick transactions arriving from multiple clients. In this case, you may experience a gradual
decrease in throughput. To check whether this problem exists, you can also periodically check the
"Statistics" page for the Communications Process in Enterprise Server Administration, which will display
a growing list of tasks waiting to run. To work around this issue, you need to use the new configuration
option, "enable mutex sweep", described in the product help.

2789874 (1095856)
• Certain Enterprise Server administration actions such as notifying a running enterprise server of a

security update could cause MFCS to hang.

2784219 (1095045)
• Requests using the CICS Transaction Gateway or the CICS External Call Interface protocol could hang

and time out when running against Enterprise Server 2.2 and 2.2 Update 1, due to an issue that
occurred when multiple CTG requests arrived at the server in a short time.

2681548 (1092656)

MF Directory Server

Back to the list

• The Enterprise Server Administration no longer terminates when trying to display a list of users
registered on an external Security Manager.

2788461 (1095505)
• The 64-bit MFDS is now able to read and write XML configuration data.

MFA Server

Back to the list

• This release provides a fix for abend 0C4 in XDBWWWM0.

MFA SyncMon

Back to the list

• Previously, PDS members without ISPF statistics caused an error message "Input string was not in a
correct format" when processing the timestamp. Now the current time is used. SyncMon2 also
downloads the entire PDS every time.

2783738 (1094996)
• The product now displays a useful error message and not an exception when a user specifies an illegal

output.
• Removing a rule from the SM2 dialog no longer causes other rules to be removed from the dialog.

MFBSI

Back to the list

• Support has been added for the Control-M $JULIAN/$GREG/$WEEK# functions using the Control-M
expression or variable parameters.

2698531 (1094301)

MFIO

Back to the list
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• Specifying a leading ";" in an environment variable containing a file path no longer results in the file not
being found.

2693286 (1093707)

MTO: CICS ECM/Preprocessor/Translator

Back to the list

• You no longer receive CICS AEIA errors generated on a BMS MAP LOAD.

2792682 (1096074)

MTO: CICS Emulation

Back to the list

• Passing an invalid program name to a CICS function (such as LOAD, XCTL or LINK) could cause CICS
to get into a loop and the transaction would appear to hang. This has been fixed and in such cases, a
correct EIBRESP code is returned.

2786729 (1096085)
• If an error occurs during PLTPI processing, mainframe CICS enterprise servers now display a

notification which enables the operator to cancel the startup or ignore the error. The new environment
variable ES_ABORT_PLTPI_ERROR provides a limited support for configuring this behavior. Using this
environment variable, you can configure an enterprise server to abort the initialisation if a PGMIDERR
error or an ABEND occurs during PLTPI. The control is positional: ES_ABORT_PLTPI_ERROR=YN -
abort on PGMIDERR ES_ABORT_PLTPI_ERROR=NY - abort on ABEND
ES_ABORT_PLTPI_ERROR=YY - abort on PGMIDERR or ABEND

2785311 (1095152)
• On an EXEC CICS RECEIVE, the BMS field values are now correctly received when a map is not

positioned at line 1, column 1.

2780436 (1094636)
• ASSIGN INVOKINGPROG now correctly returns the name of remote invoking programs. Also, when a

program is invoked using an XCTL or a LINK call from a program invoked through a DPL call, the
INVOKINGPROG name is now set correctly.

2780411 (1094631)
• You no longer receive an RTS 114 in dfhebms in a conversational transaction when there is an EXEC

CICS DELAY between the SEND and RECEIVE statements.

2780331 (1094621)
• Trying to access VSAM files using the alternate index (without opening the file first) would previously

produce an error.

2695934 (1094069)
• Previously, the BMS paging overflow condition was raised incorrectly when using trailer maps.

2694503 (1093880)
• Previously, when a group contained the length and the attribute on the group descriptor but not on the

group item, the length and the attribute for all items of a group was always being taken into an account.

2685387 (1093120)
• When a system abend is issued, the process should terminate normally cleaning up temporary files and

releasing resources (this is known as a soft-kill). If the process cannot be ended normally, casmgr
terminates it without performing a clean-up and releasing resources (this is known as a hard-kill) and
also issues a console notification. If the "dump on System Abend" option in ESMAC is enabled, this also
produces a dump file with information about the system abend.

2652085 (1093330)
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MTO: CICS ESMAC

Back to the list

• You can now use the environment variable ES_DISABLE_DFLTUSR_SIGNON to control default user
signon to ESMAC: if set to 'Y' or 'y', then the default user is not used, and the SIGNON screen is
presented for the user to sign on.

2649506 (1090376)

MTO: CICS Supplied Transactions

Back to the list

• When installing an FCT and the file had previously been installed, the entry in the alpha chain was not
deleted which would then corrupt the chain.

2675650 (1092077)

MTO: IMS DB

Back to the list

• When an IMS application compiled as EBCDIC issued an INIT STATUS call, the DB PCB status codes
were incorrectly initialized to ASCII spaces.

2789287 (1095804)
• If a data scrape is required for a database as part of the automatic rollback recovery, the time when the

data scrape started and when it ended will be recorded in the ROLLBACK.LST file.

2784951 (1095117)
• When using the IMS feature LOCALDLI, the DB position was lost when a DLI or a DBB application

switched to another PCB, then issued a DB call and then returned and issued a get-next call.

2698794 (1094555)
• When using IMS DB with XA resource manager(s), there is no longer a small window of opportunity for

mixed results if the IMS DB Control process crashed between the last DB call from an application and
the commit.

2694104 (1093779)

MTO: IMS MFS

Back to the list

• The DPM device type is not supported and, if found in the MFS source, MFSGEN used to fail. The
generate process should not abort in such cases so, instead, you now receive a warning message that
these types of devices are not supported, and MFSGEN will continue for the other device types in the
source file.

2790130 (1095760)
• Output screen fields will now be padded correctly. In order to apply the fix, you must regenerate the

MFS sources. The rules for padding are that any FILL characters specified on the DPAGE macro always
take precedence over any FILL characters specified on the output MSG macro. If no FILL characters
are specified, the default behavior is to pad with the SPACE.

- DPAGE must specify FILL=NONE in order for FILL characters from the output MSG macro to take
effect.

- FILL=NULL means that no padding is done. If a NULL character (default is X'1A') is moved to the first
byte of an output field, no padding is done. This mimics mainframe behavior. If the NULL character is
moved to any other position in the field, then padding is performed after that NULL.

2695885 (1093971)
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MTO: IMS Other

Back to the list

• When a batch program defined with the processing option GO opened an IMS database in read-only
mode before any other access, the database was incorrectly opened exclusively.

2789746 (1095709)

MTO: IMS TM

Back to the list

• Receiving IMS Connect requests with no data (for example, acknowledgement (ACK) messages) no
longer produce a Run-Time System error.

2794885 (1096358)
• Issuing a /STOP USER command from ESMAC no longer results in an RTS 114 error.

2790030 (1095747)
• You can now use the ES_IMS_SYSABEND_RESTART_TRAN environment variable to configure the

IMS feature of automatically restarting aborted transactions after an Enterprise Server system abend.
Set ES_IMS_SYSABEND_RESTART_TRAN to "Y" to enable transaction-restart or to "N" to disable it.
By default, transaction-restart is enabled.

2784980 (1095125)
• You no longer receive an error RTS200 after performing an IMS logon twice as the same user.

2784536 (1095066)
• Heavy IMS Connect traffic no longer causes the IMS message queue to fill up abnormally.

2782816 (1094887)
• In ESMAC, changing the Codeset property of an IMS transaction from EBCDIC to ASCII is now

processed correctly.

2780468 (1094826)
• CASTMC no longer crashes when the ES_OTMA_TIMEOUT variable is specified.

2699870 (1094445)
• Using an express alternate PCB to do an insert no longer causes an incorrect DFS2082 message.

2685153 (1093050)

MTO: JCL ESMAC

Back to the list

• Using the JCL OUTPUT statement to specify a class for a spool file no longer leaves the "active"
cesspool present after the job has ended.

2792943 (1096043)
• Previously, on the JES spool screen in ESMAC, if an automatic refresh was set up, the screen would

revert to displaying the contents of the Output queue after a refresh even if the radio button for another
queue was selected and showing as enabled on the screen.

2785064 (1095144)

MTO: JCL MVS

Back to the list

• An error when reading data from SYSTSIN in an IKJEFT job, which caused an execution loop, has been
corrected.

2787712 (1095763)
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• A problem that caused a DD override to be applied to the wrong procedure step when duplicate
procedures were used has been corrected.

2786158 (1095283)
• All system abends of the format S<x>22 (except S722) cause the system to terminate the job step and

bypass successive steps. For example, when executing an IF/THEN/ELSE/ENDIF statement in the JCL,
any of the supported system abend codes (except S722) produced on the IF statement will bypass the
THEN or ELSE clauses, regardless of any tests on the IF statement. When S722 is produced, the
successive clauses are processed as normal.

2695873 (1093984)
• When running IKJEFT* steps, if a serious file error occurs when reading the command file, the step will

exit with a non-zero COND CODE.

2685678 (1094478)
• An error with JES printing, where the file was being deleted before it had been printed, has been fixed.

2676540 (1092223)
• A JCL error is always generated when a literal within a JCL stream contains an opening quote but no

closing quote. Previously, in certain circumstances, an attempt was made to process such literals,
resulting in unexpected behavior.

2671742 (1092195)
• Using the DLM option on a DD statement sometimes caused problems with processing quotes on the

PARM option in a subsequent EXEC statement.

2648116 (1089458)
• JCL PROCs' variable substitution now works correctly for nested PROCs when the PROCs use the

same variable name.

2511372 (1078961)

MTO: JCL System Catalog

Back to the list

• A problem where JCL sysout showed "€" instead of spaces has been fixed.

2698575 (1094331)
• Deleting dynamic PDS member files from the catalog did not remove the profile file (*.pro). The file will

be deleted now.

2696480 (1094210)
• You no longer receive intermittent CTF trace error messages in the ESMAC Catalog view page.

2693148 (1094423)
• PDS libraries now support environment variables in the PCDSN.

2605606 (1087110)
• When allocating a dataset, if you specify a PC name, the system catalog API checks that PC name. If

the name starts with the string "<CATALOGFOLDER>" or with an environment variable, the system
catalog API also checks any slashes in the name and, if necessary, automatically changes them to the
ones appropriate for the OS system on the machine (Windows or UNIX).

MTO: JCL TSO

Back to the list

• Calling setenv with a field shorter than the maximum allowed for DsnAndDcb no longer results in a Run-
Time System error 163.

2668741 (1091426)
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MTO: JCL Utils

Back to the list

• If not specified for SYSUT2, RECFM is now correctly copied from SYSUT1 to SYSUT2.

2788751 (1095629)
• A problem which caused exclusive locks to be kept inappropriately when allocating a GDG bias has

been fixed.

2787281 (1095459)
• DSNALI now accepts call arguments in EBCDIC format.

2694219 (1093848)
• Zero length records are now allowed for all variable files. For ESDS and KSDS files, the minimum

record length should be at least 1.

2679809 (1092804)
• The IEBGENER utility was not writing the "number of records copied" to SYSPRINT when SYSPRINT

was defined as LSEQ.

2679194 (1092557)
• Before deleting a spool file, Spool housekeeping now checks that the file does not belong to any active

job. Previously, when short retain times were specified, a spool file could be deleted before its parent
job had finished.

2676836 (1092207)
• When emulating the IEBCOMPR utility, the comparison only stops processing when 10 consecutive

mismatches are found.

2662123 (1090743)
• When a LSEQ SYSUT1 file is copied to a SYSUT2 spool file with no DCB, the default RECFM is now

correct.

2658284 (1090437)
• DSNRLI calls to a SIGNON or a CREATE THREAD following a TERMINATE THREAD are now being

passed to the switch modules correctly.

MTO: JCL Utils - IDCAMS

Back to the list

• The IDCAMS REPRO command now allows an empty dynamic PDS member to be used as INFILE, if it
is either an existing PDS member, or if it has been opened for OUTPUT/EXTEND/UPDATE.

2788741 (1095559)
• The LISTCAT LVL command now returns a return code of zero for empty GDG base entries, to emulate

mainframe behavior.

2787482 (1095522)
• IDCAMS ALTER no longer renames the catalog entry of a file if it is not possible to rename the physical

file.

2695027 (1094111)
• The IDCAMS DELETE command now supports the use of wildcard characters when deleting dynamic

PDS members.

2684823 (1094971)
• IDCAMS now processes TSO ALLOCATE statements.

2581587 (1084939)
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NCG

Back to the list

• Using a "MOVE alphanumeric-item to numeric-item" statement in programs generated with the
CHECKNUM directive now correctly results in a Run-Time System error 163 (invalid numeric data)
message.

2796191 (1096340)
• Building programs that use DIALECT(RM) and that contain calls with more than eight parameters no

longer fails with a RTS 114 error.

2788746 (1095583)
• An issue with statements of type "compute edited-item = expression", where expression evaluates to a

value larger than the value that edited-item can store, and so truncation is required, has been fixed. This
only affected Intel x86 32-bit generated code when the HOSTARITHMETIC Compiler directive was set.

2782400 (1094841)
• Compiling code that contains alphanumeric intrinsic functions with very long parameters could

previously result in an error at generate time. It now generates successfully.

2782306 (1094942)
• A bug in the MOVE statement where the source item is S9(15)V99 COMP-3 and the target item

S9(8)V9(9) comp-3 has been fixed.

2697129 (1094607)
• The performance of arithmetic with COMP-3 items on the 390 platform has been greatly improved.

2683340 (1092877)
• Programs that include 8-byte comp/comp-5 variables in a PERFORM loop termination condition, with

the OPT Compiler directive specified, now compiles successfully in 32-bit mode.
• An issue with the code generated for alphanumeric moves on Intel x86-32 when the OPT(4) Compiler

directive was specified has been fixed.
• You no longer receive an RTS 114 error when processing invalid directives.
• You no longer receive an RTS 200 error in debuggable generated code (.gnt) programs compiled with

the amode(31) Compiler directive.
• A problem with setting breakpoints on some EXEC SQL statements has been fixed.

OO Run-Time System (32-bit)

Back to the list

• Native object-oriented programs with multiple methods that use local-storage data now execute as
expected.

Open PL/I Compiler

Back to the list

• Performance improvements have been made to the TRANSLATE built-in function when the second and
third arguments are string literals or named constants. Performance improvements have also been
made to the HEX built-in function.

2790431 (1095819)
• An incorrect error diagnostic when using DEFINE POSITION no longer occurs.

2783689 (1094978)
• An incorrect error diagnostic when using DEFINE POSITION no longer occurs.

2783285 (1094943)
• A problem using the REPEAT built-in when compiling with the -opt compiler option no longer occurs.

2783206 (1094935)
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• You can now specify the maximum FIXED DECIMAL precision. Note that this may affect FIXED
DECIMAL calculations.

2780021 (1094568)
• An asterisk iteration factor in an INIT clause is now ignored when applied to a non-array. For example:

DCL SC2 CHAR(3) INIT((*)'A'); INTERNAL: The attachment in the RPI has 3 examples with problems.
This specifically addresses the issue with "SC2". The issues with "SC3" and "AR5" are addressed
different RPIs, 1095134(SC3) & 1095135(AR5).

2779481 (1094510)
• The Open PL/I compiler now produces an ERROR-level diagnostic for a scalar item declared with a

non-asterisk INITIAL repeat factor.

2779481 (1095134)
• ON STRINGRANGE and ON SUBSCRIPTRANGE no longer report as unsupported when using -range.

2699544 (1094353)
• ON STRINGRANGE and ON SUBSCRIPTRANGE no longer report as unsupported when using -range.

2699544 (1094354)
• A problem with the divide (/) operator during restricted evaluation no longer occurs.

2699232 (1094307)
• The Open PL/I Compiler now performs Restricted Expression evaluation on INITIAL repeat factors.

2698703 (1094272)
• DEFAULT RANGE attributes are no longer incorrectly applied to incomplete declarations with FIXED or

FLOAT attributes.

2698702 (1094268)
• The RANGE parameter of the DEFAULT statement now supports multi-letter sequences when applying

defaults.

2698697 (1094265)
• The RANGE parameter of the DEFAULT statement now supports multi-letter sequences when applying

defaults.

2698696 (1094262)
• The DEFAULT statement with an attribute expression is not supported; however, the Open PL/I compiler

accepts the following construct DEFAULT (RANGE(simple-spec) & ^PARAMETER) attribute-list ;

2697197 (1094149)
• When the message limit is exceeded, the EXEC preprocessor now issues the message: mmaxmsgs.pl1

(19,29) : Severe MPLIE00103S : Message limit of nnnn exceeded. Processing terminated.

2676683 (1092198)
• The OPTIONAL attribute and the OMITTED built-in are now supported.

2548630 (1082054)
• Links no longer fail on Windows when using ldpli without the -out:filename option on an object file

whose file name included spaces. ldpli now correctly creates the .exe with spaces in the file name.
• The -agginit compiler option now applies only to scalar arrays.
• The compiler now diagnoses a subroutine that is invoked as a function. In addition, the OPTIONAL

attribute is now supported in a returns descriptor, so that a function can be invoked by a CALL
statement.

Open PL/I Debugger

Back to the list
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• Previously, if utilizing the new codewatch notifications, it was possible to trigger an ONKEY condition
within the CWNOTIF routine which resulted in an infinite loop as it tried to report the ON KEY on unit
recursively.

2693088 (1093591)

Open PL/I Macro Preprocessor

Back to the list

• The PL/I macro preprocessor now supports the use of HEX literals such as 'F1F2F3'x within the PL/I
macro logic.

2780818 (1094659)
• Previously, if a PL/I macro started in a column in the original source code so its generated code would

cross the right margin without any appropriate place to wrap the line, you ended up with a broken token.
In this scenario, we now correctly mimic IBM's behavior and start the generated macro code on a new
line at the left margin.

2780678 (1094656)
• The PL/I macro preprocessor has been enhanced to support the REPEAT Built-in function.

2780649 (1094642)
• If using %INCLUDE with a %IF-%THEN and a %ELSE, the macro preprocessor now correctly

recognizes the %ELSE and does not issue a syntax error.

2780619 (1094639)
• If a PL/I macro generated text requiring a RESCAN, and the generated text contains a macro that itself

generates text longer than 4096 bytes, a potential memory overwrite no longer occurs.

2780595 (1094638)
• Previously the PL/I Macro preprocessor parsed but ignored the optional third parameter of the INDEX

builtin function. The third parameter is now honored.

2697198 (1094142)
• A trap no longer occurs when the same %INCLUDE is used multiple times within either a PL/I Program

or another %INCLUDE and the -full_list macro preprocessor option is specified.

2696880 (1094084)
• The PL/I macro preprocessor now allows use of the compound operators +=, -=, *=, and /= within macro

assignment statements.

2695884 (1093972)
• If your source code contains '5B'x, '7A'x or '7B'x characters, the Macro preprocessor no longer replaces

them with an ASCII Space '20'x when invoked. The '5B'x, '7A'x and '7B'x characters are allowed to flow
through.

2675830 (1092092)
• A 9/139 error no longer occurs when attempting to open a "DUMMY" JCL DD from within a PL/I

Program where there was no DCB specified in either the program, nor in the JCL (other than BLKSIZE).

2675632 (1092067)
• The Macro preprocessor now finds files when using the -isuffix option and using unquoted %INCLUDE

names that already contain an appropriate extension. For unquoted names, the Macro preprocessor
first looks for the name as specified. If not found, it then appends the specified extension and tries
again.

• You no longer receive a message "VARIANT() string not defined" if the -variant option is not specified.
• A multi-line comment immediately followed a token with no interceding space no longer causes the

%LINE compiler directive to work incorrectly.
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Open PL/I Run-Time System

Back to the list

• The INDEX, VERIFY, and SEARCH built-ins now raise the STRINGRANGE condition when the start
position is greater than the length of the string to be searched, and the -range compiler option is used at
compile time.

2780174 (1094585)
• The SIZE condition no longer generates a SIGSEGV when raised for an assignment statement.

2699368 (1094329)
• Previously, the FILEDDINT() built-in function returned the logical record length for variable length files

(RECFM=V). It now returns the physical record length.

2679693 (1092483)
• Line spacing now matches the behavior of z/OS when a LINE(1) format item follows a PAGE format

item.

2673335 (1091862)
• Spacing when using LINE(1) in a PL/I program now matches the behavior when running the program on

z/OS.

2673335 (1091863)
• A PUT EDIT statement using the LINE(x) format item when there is unflushed data in the stream buffer

no longer causes an incorrect calculation of the number of lines to move forward. Previously the LINE(x)
format item did not account for unflushed data that might increment the line when flushed to disk.

2673335 (1091864)
• The LINENO() built-in function no longer returns a value that differs from what is returned on the

mainframe.

2638051 (1088614)
• A trap no longer occurs when calling PLIDUMP with the linker option set to /PDB:none. Setting the

linker option /PDB:none is not recommended with PLIDUMP as it greatly impacts the ability to walk the
stack and generate diagnostics.

2604011 (1086995)
• Using GET EDIT on a line sequential input file containing blank lines of zero length no longer skips the

first line.
• When using a PUT EDIT with an F format item that was too small for a FLOAT BIN() number, the

OVERFLOW condition was erroneously raised instead of SIZE. SIZE is now raised in such scenarios
but only if enabled.

• Evaluating the contents of a CHAR VARYING variable while running in -bigendian mode on a little
endian platform no longer results in incorrect quotes showing the end of the string, incorrect length
reporting in the debugger. Using the LENGTH built-in still worked properly for the same function. Only
the debugger function did now work properly.

Open PL/I SQL Preprocessor

Back to the list

• A new exit enables users to suppress or change the severity of error messages. Contact Micro Focus
SupportLine if you need this functionality.

2787987 (1095485)
• The DB2 pre-compiler now supports host variable names greater than 31 characters for PL/I.

2783693 (1094980)
• The DB2 pre-compiler no longer generates the wrong code for SQL INSERT statements that result in

MPLIE0995S compile errors depending on which program was used to compile application.

2783344 (1094989)
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• A problem using the LIKE attribute with a BLOB (Binary Large Object)no longer occurs.

2783284 (1094941)
• Restricted expression evaluation involving MAXLENGTH of a CHAR VAR BIGENDIAN data item no

longer causes error MFPLI02000A.

2783281 (1094940)
• Compiler diagnostics for EXEC statements in generated PL/I code now reflect the correct line number.

2685591 (1093083)
• PL/I functions now work with EXEC SQL statements as expected.

2681499 (1092667)
• The macro preprocessor inappropriately generated extra blank lines when -margins 1,250 was used in

place of the default or 2,72. This behavior caused inaccurate line numbering in the debugger and made
the source appear out of sync with the debugger.

Run-Time System

Back to the list

• You can now use a configuration file that has a spacey filename to start Audit Manager as a service.

2785459 (1095200)
• The debugger now displays correctly the content of non-ASCII characters in programs compiled with the

CHARSET(EBCDIC) Compiler directive.

2782246 (1094947)
• In some situations, the processing of a Run-Time System error in an Enterprise Server container could

cause the container to hang or crash. This has been fixed.

2690883 (1094783)
• PL/I CICS error handling is now fully supported.

Setup Issues

Back to the list

• The mfsupport permissions have been modified so that any user with access to the product can now
run mfsupport.

2781319 (1094713)

SQL: Cobsql

Back to the list

• COBSQL now correctly processes source lines that only contain a single character at column 72.

2781493 (1094727)
• COBSQL now correctly processes SQL statements with continuation lines.

2781299 (1094716)

SQL: DB2 ECM

Back to the list

• A new directive option, DB2(ALEBRA), has been added to the DB2 ECM preprocessor to prevent
ASCII/EBCDIC translation of host variables used in SQL statements. DB2(ALEBRA) is applicable only
when using the EBCDIC character set and the Alebra Remote DB2 Access software.

2789897 (1095736)
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• Programs using SQL TYPE AS CLOB compiled with host variables were flagged with COBCH0233S
Compiler error because the reserved word "AS" is not supported in mainframe dialects such as
Enterprise COBOL. The DB2 pre-compiler now resolves this by adding "AS" as a valid reserved word.

2698988 (1094584)
• While editing the source code in the IDE during syntax checking, the DB2 pre-compiler sometimes

generated incorrect error messages for DECLARE CURSOR statements if they were defined in the
WORKING-STORAGE section when the DB2 BACKGROUND PARSING option was set to NONE.

2698133 (1094267)

SQL: HCO for SQL Server

Back to the list

• SQL decimal result columns with a maximum precision of 38 could not be retrieved.

2698172 (1094215)
• The HCOSS data conversion tool did not support mainframe DB2 tables and corresponding indexes

that were created under different schemas.

2696111 (1094539)
• HCOSS did not correctly extract mainframe syssequence table entries with MAXVALUE greater than 31

digits.

2696106 (1094067)
• When HCOSS converts DB2 TIME() functions, the seconds component will now be truncated rather

than rounded in order to match mainframe behavior.

2692917 (1093579)
• HCOSS now supports DB2 multi-row INSERT statements.

2683979 (1094036)

SQL: OpenESQL

Back to the list

• The OpenESQL preprocessor incorrectly terminated a host variable lookup resulting in a COBES0109
error.

2795391 (1096265)
• Using a SQL Server fast forward cursor with an ODBC driver that does not support MARS caused a

rollback when the cursor was closed.

2793798 (1096126)
• Applications migrated from earlier products that used the tokens ON and ROW_NUMBER as column

names in SQL statements were compiling with errors.

2793301 (1096088)
• The OpenESQL preprocessor produced a compilation error for EXEC SQL select ... INTO

<TableName> ... END-EXEC.

2792715 (1096102)
• The OpenESQL runtime for ADO.NET was incorrectly returning the native database error in

SQLERRD(1).

2790152 (1095758)
• A problem fetching decimal columns using OpenESQL for ODBC in locales where the decimal point is

not '.' has been fixed. In addition, to optimize performance for the majority of ODBC applications, the
default setting for SQL(DECDEL) has been changed from NODECDEL to DECDEL=LOCAL. Use an
explicit SQL(NODECDEL) directive for Windows applications that change the effective locale
dynamically at runtime.
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2788986 (1095766)
• The insertion of values larger than 8000 characters from a PIC X host variable into a SQL Server

VARCHAR(MAX) column caused an error.

2787574 (1095428)
• Some valid ODBC SQL expressions caused the OpenESQL preprocessor to issue errors when it

encountered a 'BY' token.

2787068 (1095429)
• Valid SQL "PARTITION BY" clauses caused compiler errors when using OpenESQL.

2786991 (1095386)
• Performance of the OpenESQL runtime system for ODBC required improvement when fetching

character data.

2785410 (1095165)
• The OpenESQL preprocessor generated invalid code resulting in undefined ECM error code 302 when

an array host variable was mixed with regular host variables in a parameter list in the EXEC SQL CALL
statement.

2785284 (1095354)
• A memory leak occasionally occurred when multiple prepares of the same dynamic SQL statement

existed in the OpenESQL JDBC runtime system.

2784039 (1095123)
• The OpenESQL preprocessor incorrectly interpreted the SQL CONCAT character as DBCS when using

SQL(CONCAT=124) for the CONCAT character, resulting in compilation error.

2783615 (1094981)
• When compiling for ODBC, the OpenESQL preprocessor now generates an error message,

COBES0123, when it encounters an EXEC SQL statement that contains a host or indicator variable that
uses a subscript. Subscripts of this type are not supported in ODBC.

2781022 (1094686)
• The GEN-HV-FROM-GROUP SQL compiler directive option intermittently caused truncation of SQL

VARCHAR data type occurrences.

2780748 (1094649)
• SQL(CHECK) caused compilation errors when compiling source programs containing DBCS characters

in column names. Programs containing DBCS characters in column names that were compiled using
SQL(NOCHECK) caused runtime errors.

2780185 (1094588)
• The GEN-HV-FROM-GROUP compiler directive option has been added to the OpenESQL preprocessor

to support the selection of multiple levels in a group item. Specify SQL(GEN-HV-FROM-GROUP) when
compiling to generate host variables for each elementary definition in a group record.

2699622 (1094395)
• OpenESQL for JDBC did not correctly open insensitive cursors.

2699442 (1094415)
• OpenESQL Assistant was inconsistently inserting the query function in the "B" area for queries and

column 8 for other code.

2697908 (1094190)
• The OpenESQL preprocessor sometimes incorrectly defined host variables when an indicator variable

array was used with an SQL statement.

2696332 (1094052)
• You no longer receive errors when parsing Oracle INTERVAL expressions.

2694071 (1094337)

72 | Resolved Issues



• A problem that prevented a COBOL stored procedure from being called from a nested trigger has been
fixed.

2690749 (1094042)
• The restriction that program names in an application must be unique in the first 24 characters in order

for OpenESQL to handle cursors correctly has been increased to 30 characters. This is to restore
backwards compatibility with earlier Micro Focus products.

2685901 (1093808)
• HCOSS now provides better control for ODBC applications that use data that: o Uses the DATE and

TIME formats specified by SQL(DATE) and SQL(TIME) o Is stored as character data in the database
You can now do any of the following: o Specify host variable types to use with DETECTDATE. o Set the
ODBC runtime to determine parameter data types by querying the server (this option uses additional
runtime overhead). o Tag string literals in SQL statements with special SQL comments that specify the
type of literal. With this option, literals tagged with /*#CHAR*/ are not reformatted when
SQL(DIALECT=MAINFRAME) is set.

2685625 (1093540)

Unassigned

Back to the list

• A channel created by a program invoked by a CALL statement is now visible to the programs running at
the same level.

2698335 (1094225)

Visual Studio IDE

Back to the list

• When debugging a native COBOL program and querying an alphanumeric data item, you now have
access to the visualisers to view the data.

2785437 (1095170)
• A problem where WPF event handler methods were not created in the code when using Visual Studio

2013 Update 2 has been resolved.

2782479 (1094867)
• All run-time tunables can now be set using the Application.config file in the Visual Studio IDE.

2779522 (603989)
• The SQL page in the project's properties now handles SQL(NOINIT) correctly.

2697905 (1094189)
• Using the left button of the mouse to click in the editor margin below the end of a source file no longer

causes an exception to occur.
• The Create New Enterprise Server dialog no longer loses track of the location of the server templates.

(604449)
• The "Submit JCL" context menu command is now available for JCL files that are part of Managed

Mainframe Subsystem projects and enables you to submit the files directly from within Solution
Explorer.

• After installing or updating the product, the options in Tools > Options > Text Editor > Micro Focus
COBOL are now set correctly.

• Previously, using the call hierarchy would lock some source files until the next time the IDE performed a
syntax check.

• If you used the OF or IN phrase with a COPY statement, it was not possible to show the corresponding
copybook in the Expanded Copybook view or open it using the Open Document command. This fix is
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not available for copybooks stored in library files (where you have used the COPYLBR Compiler
directive).

• If the Call Hierarchy is requested for the same named item in more than one program both items are
now displayed.

• When navigating from the results in the Call Hierarchy window, the caret is now correctly positioned at
the beginning of a method name, paragraph name or section name.

• If a copybook contains multiple consecutive COPY statements, showing those consecutive copybooks
no longer causes Visual Studio to display an exception message.

• When stepping from a program into another program and directly into a copybook referenced using
COPY... REPLACING, the expanded copybook view now correctly shows the contents of the copybook
with the replaced values.

• If you opened a source file in more than one view and if you then attempted to debug that file, the
debugger could sometimes fail to step into the expanded copybooks view and could sometimes show
other unpredictable behaviour.

• When building projects that contain IMS files in Visual Studio, the Error List window now displays any
error messages reported by the IMS compiler if the build output verbosity is set at the default setting of
Minimal.

• When adding existing files to a native mainframe subsystem project, the Add Existing Item dialog now
shows the correct set of files.

Web Service Client

Back to the list

• Namespaces not declared on the schema root, i.e. declared either with an element declaration or on the
WSDL root, will now be processed properly and no longer ignored.

2583853 (1085102)

XDB Server

Back to the list

• XDB Server now supports a value of up to 256G for the PIECESIZE clause on a CREATE INDEX
statement.

2784918 (1095176)
• The syntax compatibility of "partition by size every integer G" in the CREATE TABLE SQL statement has

been fixed.

2784917 (1095177)
• The MAXPARTITIONS clause is now allowed on CREATE TABLESPACE statements.

2784916 (1095178)
• The DATACLAS clause is now supported on CREATE STOGROUP statements.

2784915 (1095179)
• You now receive correct results when certain SQL statements are used with CASE and ORDER BY on

the projection.

2781926 (1094773)
• You can now use the reserved word DOCUMENT in SQL statements as an identifier.

2781673 (1094744)
• XDB server threads no longer exclude themselves from executing. Previously, this happened as a result

of conflicts with rapid sequence update operations.

2695974 (1094282)
• A problem where CICS SEP processes would run out of SQL Option cursors has been resolved.

2693104 (1093639)
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• A problem where a large number of concatenations could cause an XDB engine stack overflow has
been resolved.

2686565 (1094072)

XDB: Problems not classed above

Back to the list

• Bootstrapping now assumes SBCS and conversion to Unicode tables is handled automatically.

2699728 (1094431)

XML syntax support runtime

Back to the list

• The HTMLPP preprocessor now handles copybooks with filenames longer than eight characters
correctly.

2783315 (1095092)
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The WebSync service, where you can download fixes and documentation updates.
• The Knowledge Base, a large collection of product tips and workarounds.
• Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.
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Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2014. All rights reserved.
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